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The best way fo think of & layer is to lock at it like a sheet of clear plastic, i you tay this | If you decide you no longer want a layer, it is easy to remove
plastic on top of an image, you can paint on it, place text on it, or put another image on | it. At the bottom of the Layers paiette, there is & garbage can
it, without affecting the image underneath, Moreover, you can put additional sheets of icon. Simply drag the layer you no longer need over the
clear plastic (layers) that contain graphics or parts of an image on lop of cther sheets to | garbage can.

compose & complete image out of many components,

The beauty of fayers is the ability to perform actions on a layer by layer basis. If you
need to edt one part of your image but not another, simply create a layer including the
piece that needs editing, and edit i on that fayer. You can also create a layer over your
image to allow you to perform edits without affecting the criginal. You can even compare
muliple effects or retouches by using a different layer for each one, and then toggling
them on and off against the background image. Layers are endlessly useful in
Photoshop.

The image below is made of three layers: one has the writing, one has the background,
and one has the sunflowers. You can see the layers in the Layers palette {o the right of | Another way to delete the layer is to right click the layer, and
the image. The picture on the right is the three layers that compose the piciure on the from the shortcut menu, choose Delete | ayer, as shown

left. below. You can also choose Layer - Delete — Layer.

Layer Properties...
Blending Optians

Merge Capviry
Meige Visible
Flatten Tmage

To link fayers, select the fayers you
want to link {using Ctri + click), and then
either click the link tool at the bottom of
the Layers palette, or choose Link .
Layers from the Layer or palette options
menu. When you click a layer that has
iinks, a fink icon appears beside it and
any layers it is linked to.

= LINK indicator

There are three easy ways 1o create fayers:
- Use Layer — New — Layer
- Press Shift + Cirl + N
- On the Layers palette, click the New button
- Layer — Naew — Layer via Copy
- Layer — New - { ayer via Cut

if you want {o temporarily disable a
link, you can Shift -+ click the link icon
for the layer. When you want Lo re-

Link tool \ . ; o K
activate the link, Shift + click it again.

Hee refers to how we perceive the dominant wavelengths of a color source. It is the characteristic we are describing when we refer to a color as green, or
purple, of red. You could think of hue in the same way that you think of shades or fones of color. Some people use the word hue in the same way they
would use the word color.

Saturation refers to how we perceive the ratic of the dominant wavelengths to alf the other wavelengths of a color source. In other words, saturation can
be described as the strength or intensity of a shade or tone of color. A color that is very saturated will appear strong and vivid to our eyas, while a cofor
that Is much less saturated can appear 1o be washed-out or weak. A color that is completely desaturated will appear as a shade of gray.

Brightness refers to how we perceive the amount of light energy given off by a color source. People often think of brightness on a scale from dark to light,
with black having very little brightness (light energy), and white having maximum brightness. As it turns out, any of the colors that can be described in
terms of red, green, and biue values can also be described in terms of hue, saturation, and brightness values. Some people find that the hue, saturation,
and brightness scheme is a more intuitive and natural way to view color than the RGB scheme.




The Paint Bucket, alse known as the Fill fool, is used to fill a canvas, a
tayer, or a selected area with cofor by clicking in it. |t will replace all pixels
that are the same or close to the pixels that you click on, based on a
telerance that you can specify.

Here is a before and after look at the sunflower image with the
background darkened to & navy biue:

The Pen ool is another useful vector graphic tool provided in Photoshop. The
main purpose of the Pen tool is to allow you to create vector paths.

A path can be used to get very fine control for filling a specified area, applying
a paint stroke along a predefined course, creating your own custom vector
shapes, or for making seleclions. The different Photoshop Pen teols provide
different approaches and options for creating paths. Creating paths with the
Pen tools is a complex subject, and takes & lot of practice.

The Pen tools {described in the order they appear in the hox above) have the
following functions.

The standard Pen fool is used to
create anchor points to join straight
fines.

This tool lets you draw with the pen
in pretty much any way you like
{similar {o the brush or pencil in this
respect).

Use this teol to add an anchor point
0 a path that has already been
drawn. Anchor points give you
control over your path; however, 100
many anchor points can give you
unexpected resulis and can make
your image harder lo edi, display,
and print,

Pen Tool

Freeform Pen Tool

Add Anchor Point Pen Tool

The Blur tool is used to soften edges and other areas of high contrast in
an image. Some users might use the Blur tool to create an out-of-focus
effect, while others might use it to deemphasize unwanted harshness or
contrast. You can also use the Blur tool 1o soften and blend artifacts left
by other image edits, like removing or adding abjects or using the Stamp
tools.

The Sharpen teol is the opposite of the Blur {ool. It increases the contrast
where you paint, giving a sharper fook o your image. The Sharpen teolis
a variant of the Blur tool.

The final variant of the Sharpen tool is the Smudge tool. It sounds a lot
like the Blur tool, bul it is quite different. I¥'s lkke someone actually
smudged your image while it still had wet paint on it. You can smudge the
image using the colors that exist in your image, or you can select the
Finger Paint option on the Oplions bar to smudge your image with the

This ool can be used 10 remove
unwanted anchor peints frem a
path.

Detete Anchor Point Tool

This ool alfows you to add handles
to a point, leiting you drag your path

Convert Point Tool

into a curve.

foreground color

The Sponge ool is used to increase or decrease color saturation.

The Burn tool will darken the regions you drag your mouse over, whereas the Dodge tool flightens them.

Use small brush sizes for detailed work, and farger brush sizes for large, evenly biended argas. if you
click the airbrush butfon at the right of the Cptions bar for the Dodge tool, you can hold your ieft mouse
hutton down and the spol beneath your mouse pointer will continue to fighten. If this butien is not on,
you must click your left mouse button to lighten the spot your peinter is over incrementally.

Drawing Straight Lines

To use the standard Pen tool {o draw a straight line or a shape made of
straight lines, click on the image canvas where you want the {ine to begin, and
then click again te complete the line. After making the second click, you now
have two anchor points. The first anchor point becomes hollow, and the {ast
anchor point is filled.

Sacond anpchor
potnt

itlad anchor
point

If you cortinue clicking, the lines will form a shape, and only the last anchor
point is filled. You can either leave the path ¢pen or close it. To leave it open,
Cirl + click somewhere away from your path. To close the path, position your
pen pver the initial anchor point so that an empty circle appears beside the
pen. Click and your shape will close.
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Section 1: Using Layers

PR

In this section you will learn how to:
v Use the Layers palette
s Hide and display layers
= Change layer transparency
= Arrange layers
= Create hasic layers
= Delete layers
» Rename alayer
s Creale alayer via cut or copy
v Use adjustment layers
= Use fill layers
= Apply effects and styles to layers
»  Group layers
»  Use Auto-Align
» Use Auto-Blend
= Duplicate layers
= Link fayers
v Merge layers
= Export layers



Adobe Photoshop CS5 Intermediate

Lesson 1.1: Using Layers

In Photoshop, the ability to work with fayers is a useful critical skill. Once you get comfortable
using layers, a world of image editing options will open up. You will be able break down your
image into several component parts, giving you the ability to single out and modify one part
without affecting any of the others. You will also be able to make parts of the image visible or
invisible with a click of your mouse. Because you can work with each layer independently, you
will be able to create and combine many different effects for different parts.of your image.

fn this lesson youwill tearn, what _' ':.___ayer is and how to create one. In addition, you will how to
delete a Iayer how to recover a deleted layer, and how to rename a new layer.

What IsA Layer?

The best way to _thi__tik of a layer is to look at it like a sheet of clear plastic. If you lay this plastic
ontop of an imééé: you can paint on it, place text on it, or put another image on it, without
affecting the image underneath. Moreover, you can put additional sheets of clear plastic
(layers) that contain graphics or parts of an image on top of other sheets to compose a
complete image out of many components.

If a fayer contains no image information it will be totally cfear and the underlying layers or

image will be visible. Each layer has an opacity setting that controls how much shows through
that layer ~ if the opacity for a layer is set at 100%, you will not see the underlying layers, If a

© 2010 Computrain Technical institute



Adobe Photoshop S5 Intermediate 3

layer contains only part of an image, the part of the layer with no image data will be
transparent.

The beauty of layers is the ability to perform actions on a layer by layer basis. If you need to
edit one part of your image but not another, simply create a layer including the piece that
needs editing, and edit it on that layer. You can also create a layer over your image to allow you
to perform edits without affecting the original. You can even compare multiple effects or
retouches by using a different layer for each one, and then toggling them on and off against the
background image. Layers are endlessly useful in Photoshop.

As mentioned above, you can adjust the opacity of each layer individually, You :Ca:;jralso set each
individual layer to be visible or invisible. Perhaps more importantly; there are’anumber of

The image below is made of three layers: one has the writing, Oqe'has.the'bg_(;_kgrdund, and one
has the sunflowers. You can see the layers in the Layers:palette to.the lgh__t‘ofirthe image.

foweoe  §
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Adobe Photoshop CS5 Intermediate 4

Here are the three layers that compose the above image:

intact, save the fife in PSD or PSB format. This Photoshop Document format will preserve all of

the individual |

and continue to'work with the original fayers. If you save your layered image as another format
type, like GIF or JPEG, the layers will not be preserved as separate editable components, The
layers will be amalgamated to form one image and will not be retrievable as separate entities
later,

There is a special layer in many images called the Background layer. You will notice it is
italicized and locked. This layer has limited functionality — you can’t change its order, opacity, or
blending mode. if you want to work on this layer in one of these ways, you have two choices.
You can duplicate the layer by right-clicking it in the Layers palette and choosing Duplicate

© 2010 Computrain Technical institute



Adcbe Photoshop CS5 Intermediate 5

Layer. Give the new layer a name, and then you can do anything you like to it. If you want to
simply remove the attributes of a background layer and convert it to a regular tayer, simply
right-click the layer and choose Layer from Background. Again, name the layer. This method
doesn’t add another layer to your file.

Using the Layers Palette

You use the Layers palette to work with layers. In the default workspace, the Layers palette is
the bottom palette, in the same zone as the Channels and Paths pafettes Make sure the Layers
palette is displayed by clicking its tab. If the palette is docked, cI1c|< the icon:to dasplay it. If you
can’t see it at all, choose Window — Layers. :

The Layers palette shows you all the layers that are in the actlve i age, Wthh 'i“é'y:ekr you are

? Mesrrerad |

Settings for active
layer:

e %eﬁeetmn bar
indicates !ayer O
which you are
working

Layer commands

Indicates whether
* Jayer is displayed

You choose which layer to work on by clicking it. The active layer has a blue bar over it. You can
view all the layers together, but your changes are applied to the currently active layer. When
you click on a layer in the Layers palette to make it active, the settings reflect this layer.

If alayer has effects added to it, the A% icon appears at the right of the tayer name. This toggles
the layer effects - if you click this, the layer expands to show what effects have been applied.

© 2010 Computrain Technical institute



Adobe Photoshop CS5 intermediate 6

Click it again, and the effects collapse. We haven’t learned about effects yet —we’ll cover them
in Lesson 1.3. Here is a layer expanded to show the effects:

SR Drop-Shadow

Hiding and Displaying Layers

You can selectively show and hide layers. This can result in variations on:the same image, or can
be used to test the effect of a layer. The eye icon to the left of the Iayer the Layers palette

indicates the layer is currently being shown. To toggle the iayer on angd off, click the
hide it, and the blank space to show it. e

Here is the flower image without the writing showing Note_thatﬂthe'ey__ icon'is present beside
the Sunflower 1 layer and the Flower background aner, andnot present beside the Title layer.

Changing Layer Opacity

As you add layers to an image, you controf how see- -through that fayer is. The opacity control
has a range of 0% to 100% - the higher the percentage, the less you can see the next layer. If a
layer takes up the entire canvas, and the opacity is set to 100%, none of the layers below that
layer can be seen. The flower image has three layers, all set to 100% opacity {remember that
the Title and Sunflower 1 layers only have images on part of the background). If the opacity of
the sunflower level is reduced (so the fayer becomes more transparent), you begin to see the

& 2010 Computrain Technical institute



Adobe Photoshop CS5 Intermediate

background layer showing on top of the sunflowers. In the image below, the opacity has been
set to 50%, so you can see the bubbles and leaves of the background layer showing on top of

the sunflowers.

A second setting for controlling opac;ty iscalled Flii'_Fll! lets *you change the opacity of the
effects that have been applied tp layer without affectmg the rest of the layer. We will discuss

using fill in Lesson 1.3.

Arranging Layers

The order of youriayers is mtegr I-to the appearance of your image. Because each individual
‘formation and effects, the question of which layer goes on top of

The layers in an image.are seen relative to their position from top to bottom in the Layers
palette, meaning the, ‘top layer in the Layers palette will be the top layer in the image. For
instance, if the top. Iayer is completely filled with image data and is 100 percent opaque, you
will not see any of the other layers underneath. The same can be said for each layer in
succession down to the bottom of the list.
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What is
Shadows
AGJUSTING 1ot e en e s e e e e L PTG CHUURUUUR 55
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Appending list KT W T 102
LT3 Co T o o OOV OO PO OO PP P PP RUUUUUOPPTOPPRUPPPRUUR - SUURTRTITOL: ORI ST 98
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And layers...
- Anti-Aliaging
' Bourjj_'? ing bo
Changing color ..
Changing font face ..
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To demonstrate this, the order of the fayers in the flower image has been changed: the
Background is now the first fayer. You now can’t see anything but this layer because it fills the
entire canvas and is 100% opaque. You can see that all three layers are stilt visible; the change is
due to the order of the layers.

{
1

Line indicating
new position
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Lesson 1.2: Working with Layers

In order to use layers in your image, you need to be able to create them. Sometimes you are
creating a layer for its content, as we saw in the fish and flower images in Lesson 1.1.
Sometimes you are creating a layer to adjust another layer in the image — for example to add
texture or color, or to adjust the contrast. We will cover adjustment layers in the next lesson. In
this lesson, you will learn how to create and delete a basic layer.

Creating Basic Layers

A blank layer is just that: blank. There is nothing on it all, and you canVuse
purpose you wish. :

There are a number of different ways to create a new blank Iayé:__
» Use Layer — New — Layer
*  Press Shift + Ctrl + N .
* On the Layers palette, click the New butn

When you create a blank layer, the New Layer dla!ogue box appears Give the layer an
appropriate name, and if you wish, choose a coior for the layer. A layer color is used for color
coding related layers, and does not affect your |mage at all. It’s a tool to help you manage layers
when you have a lot of them to. keep track of. For example you might assign the color green to
all layers of the dealing with.a spemf;c part ofthe image, or you could code content layers with
one color and adjustment aners with another (The Mode and Clipping Mask features will be
covered in future !essons } Chck OK to create the layer.

New layers appear above the selected layer, so to save yourself some time, decide where your
layer belongs, and click the layer above which you want your new layer to appear before using
the New Layer command.
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Deleting Layers

If you decide you no longer want a layer, it is easy to remove it. At the bottom of the Layers
palette, there is a garbage can icon. Simply drag the fayer you no longer need over the garbage

can.

Another way to delete the layer is to right click theJayer, an
Delete Layer, as shown below. You can also c_hob'se Layer

Laver Properties. .,
Blending Options, .,

Duplicake Lavear

) e
Corert bo Srmart Object

i P

Creste Clipping _Mésk

IMerge Down
Merge Yisibhs
Flatten Inage

TS
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If you use one of the menu methods, a dialogue box appears asking you to confirm your choice.
If you don’t want to confirm future deletions, select the Don’t Show Again check box.

Renaming a Layer

Your layer name should reflect the content or purpose of the layersiin the Flowers image, the
layer names clearly told you what was on the layer: the title, the sunflowers, and the
background. If you aren’t happy with the name you have give.a layer; or if you discover a
spelling error in it, you can rename the layer. The layer name |

[ Jocated in the Layers Properties
dialogue box, which you can see by right-clicking the layer-and choose Layer Properties, or by
choosing Layer — Properties. Replace the current name with the desired name, and then click
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Creating a Layer via Cut

You can cut a piece out of one layer and place it on its own layer. This allows you to work on
one part of the image selectively, without affecting the other parts. By using Layer via Cut,
instead of cutting something and pasting it onto a new layer, you ensure that the pasted image
lines up exactly with the image it was cut from. Layers created this way are given the default
name of Layer(n], where [n] is the one number higher than the last numbered layer. You should
rename the layer to a name reflecting its purpose. g

To create a [ayer via cut, select the part of the image that you want as a new ayer Then, click
the Layer menu, choose New, and choose Layer via Cut. i - :

Layer... Shift+Cr
Dupdicats Layer, Laver From Background, .,
Delete P Group,,,

Group From Lavers. ..

i_aver Prc-perties' o
Laver via Capy

ayur Stvle

=P B

e Fill Léy&r k.
Mew sdhistment Layar »

Creating a Layer vig Copy

Layer via Copy lSjUSt hke aye'r via Cut, except that you are leaving the source image in its place.
Like Layer vi t, you should.rename the layer after you create it.

Layer vua Copy does not reqwre a selectlon if no selection is made the entire layer will be
copied. If a selection is, m___c_]_e using one of the selection tools, only the selection will be copied
to the new Iayer Once you have decided what you want the new layer to contain, click the
Layer menu,choose New, and choose Layer via Copy.

© 2010 Computrain Technical institute



Adobe Photoshop €55 Intermediate 13

Lesson 1.3: More on Layers

Adjustment and fill layers are special types of layers used in Photoshop. An adjustment layer
does not contain any pixels; instead, it contains instructions on how the pixels in the underlying
layers will be affected. In this way, adjustment layers give you the ability to apply an effect to a
group of layers, and then at any time in the editing process, alter that effect while preserving
the integrity of original image.

if you apply effects directly to your image, it is likely you will degrade the orziéina[ image. If you
change the color or shade in an image, or apply an effect to your image, ‘you are‘changing the
pixel information in that image or fayer. If you don’t fike how your-édits turned 0 t_ you may
have to make further changes to clear up the unwanted effects. All of these operatlons on the
pixel values can degrade the image from its original state. For: example if you adjust the light
and shade in an image, it is very difficult to adjust it back to its exact: ongma state at a later
time. Adiustment layers allow you to try effects and edits: wathout affectmg the integrity of the

underlying image.

Making Adjustments with Layers

Examine this image:

The girl’s face is in shadow and needs to be brightened. By using a Levels adjustment layer, we
can brighten her without touching the underlying image.
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Here she is after applying the adjustment layer:

e SO0MAH

With adjustment layers, you are able o edit non-destructively: in other words, you can change
the way your image appears without touching the underlying image. You can create an
adjustment layer by ciicking’fg'__he__Créé_t New Adjustment or Fill Layer button on the Layers
palette, or by selecting New A:dju's__tmen___- Layer from the Layer menu.
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There are many different types of adjustment layers, as you can see from the menu:

[ L4

L:e:'ﬁfﬁels. y

Curves..,

Color Balange. .
Erightness/Contrast. ..

Black 2 White, ..
HugfSaturation...
Selective Color, .
_(;hanhé_] Mi'xér.. .
Gra_dié:n:l: Map...
Fhato Filter,.,
EXDOSUIE. ..

Smark Chiects
Yidea Layers |
30 Layers. ’

Irivert, ..
Thrgsheld. .
Posterize, .,

Levels llpws’tyo'u";-to pre':ate an adjustment layer for controlling light and
: _hé'de'_.\‘_f:i_athe'three main tonalities: shadows, mid tones, and

. highlights.

ThlS o'ption gives you much finer control over the light and shade
tonality of your image by letting you adjust a curve representing the
“tonal output for the image.

Curves:

This option gives you general control over the color balance of your
image. You could also adjust color balance using the Levels option by
working with separate red, green, and blue channels.

Color Balance ™

Brightness/Contrast Used to create brightness/contrast adjustment layers.
Hue/Saturation Create a hue/saturation adjustment layer.

Selective Color Allows you o create an adjustment layer for altering an individual
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color group (such as reds, greens, or purples) very specifically.

Channel Mixer This adjustment layer provides excellent control for the process of
turning color images into grayscale {commonly known as black and
white).

Gradient Map This adjustment layer will allow you to create a color gradient for

your image based on specific colors of your choice.

Photo Filter You can use this option to simulate the effects of photographrc filters
(such as sepia tone).

Invert This adjustment layer creates a negatlve of your __‘_nderlymg smage

Threshold This will turn your image into high contrast black and white (no gray).
With a slider switch, you can adJust the pomt (threshoid) at which
pixels become white or bIa '

Posterize Thls ad;ustment !ayer allows you to;add a posterlze effect essentially

amount}.

Don’t worry if you do not understand these effect .completely The only real way to understand
them is to get a feel for the results Expenment with: the adjustment layers options and observe
the results. The beauty of adjustment Iayers comes from the fact that you can create and delete
them as many times as you Want without affecting your original image.

After choosing the desired type‘bf adjustment layer, the relevant dialogue box appears. Simply
choose the settings you Want and the adjustment layer is created. The adjustment layer adjusts
all layers below't','so placement of an adjustment layer is important. At any time, you can
double click the adjustment fayer in the Layers palette, and the dialogue box or control for the
effect willz appear again. I this way, adjustment layers allow you to readjust the effect as much

as you ilke without degradfng the underlying image information.

As with regqjgr layers, you can configure the opacity and fill of an adjustment [ayer in the usual
way using the'sliders available in the Layers palette.

You can delete an adjustment layer in the same way that you would delete a regular layer. Just
right click on the layer and choose the Delete Layer option.
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Using Fill Layers

Fill layers differ from adjustment layers in that they don’t affect the layers underneath them.
Fill layers let you fill a layer with a solid color, a gradient, or a pattern. There are three types of
fill layers, as you can see from the Layer — New Fill Layer menu command:

ko Filber . Aralysis | Visw Wi

ﬁiew_ L
Cugplivate Laver, ..
Destete 2

Laver Properties, .,
Layer Style r

solid Colar,.., g
few Adjustnent Layver i Gradent..

- i y
Change Layer Content }i Patterr,,
Laver Content Options. .. F

Here is an overview of the options available: .

Solid color Wil fill the ad;ustment Iayer w:th the current foreground color {like the Paint
Bucket tool). E :

Gradient Will allow you to reate a color or gra\/scale gradient for the adjustment layer
{similar to the'gradlent tool) ' '

Pattern Will allow you 10 select a"nd apply a pattern to the adjustment layer (like the
Pattern tamp, but applled to the entire layer).

Using Layer §iyies and fEffé:::Ets_

Photoshop comes wnth a var:ety of special effects you can apply to any of your layers. You can
add drop: shadows, bevei ‘the edges of your layer, or overlay a pattern or gradient, When you
apply these: effects you create a Layer Style. You can use the preset styles from the Styles
palette, or you can Use the Layer Styles dialogue box to create your own style.
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Here is an image with no styles applied to it:

R AT I b T
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If you want to customize a style, choose Layer — Layer Style — Blending Options.

i
j
|
i
|

Drop Shadow...
Mews Fill Lansr b Immer Shadow.,
Mews Adjustment Layer b Quier Glow...
i e b Inner Glow..
Bavet and Errboss, ..
Satin
Layer Mask ’ Codor Ovarlay. .,

bt Pl ¥
?a'"tm Mask N Gradiant Overlay, ..

Pattarn Overlay..,
¥ Stroka,,,
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Here is an overview of the options on the left hand side:

Drop Shadow Use this if you want a shadow to fall behind the layer.

Inner Shadow This gives the layer a recessed look. The shadow appears on the
inside edge of the fayer.

Outer Glow/Inner Glow  Adds a glow effect to the layer, either on the inside or outside edge.

Bevel and Emboss Adds a beveled edge to the layer, or adds texiufr:e.

Satin Adds a satiny look to your layer.

Color, Gradient, and Overlays your layer with the gradient, c’S’lqﬁr, dr;"pgtterh"bf.-your
Pattern Overlay choice. Bl Chn

Stroke Outlines the layer with th > ‘gradient '50_55_p_a3t:'te rnv of your choice.

Here is the image with the drop shadow as set
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Adding a Color Stroke to a Layer

If you don’t want to use the Color Stroke effect provided in the Styles palette, you can stroke
directly onto the pixels of your image. Select the layer you want to add the effect to, and then
from the Edit menu, choose Color Stroke. Color stroke applies a border on a layer that is
completely filled in, or surrounds the contents of a layer that is only partially filled.

In the Stroke dialogue box, you can set the width and color of the stroke, asiwell as the position
of the stroke. This dialogue hox is being used to create a thick lime green border around an
image.
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Here is the image after these settings have been applied:

Grouping Layers

If you find that you have a iot of Iayers a'nd are having a hard time keeping track of them, it’s
time to start grouping them You. .can- thmk of grouping as storing your layers in folders to keep

track of them.
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For example, in our Fish image, we have more layers than can be seen in the default palette. If
we enlarge the palette we can them all, but if we start adding adjustment layers, we are soon
going to have enough layers that the Layers palette will become difficult to work with.

cCamcel o]

You can also create a group and then add the layers to it after. To do this, click the Group
button on the palette, and then click and drag the desired layers into the group.
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Here is our Layers palette after reorganizing the layers:

To view the layers in a group, click the arrow beside the group folder toexpa
deciding whether layers are visible on the palette; you still need to tog e thi
control whether the fayer is part of the image.

__‘it';:‘-:\’-ou are only

To ungroup the layers, do one of the following: S

» Click the group, and then from the Layer menu, choose Ungroup Layers. The folder will
disappear, and the layers will once agam-bé llsted mdmdual!y

* Right-click the group and choose Delete-G'roup A warnlng d|a!ogue box appears, and
you can choose what you wish to deiete just: the group: or the group and its contents.

* Drag the group over the garbage can. Thls w:li delete the group and all layers in the
group with no warning, so be carefui iy

» Click the group and press Delete Agaln th:s deletes the layers in the group with no
warning., ~ L o
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Lesson 1.4: Advanced Layers

R R

There are many useful things you can do with layers. You can take an image that is in pieces and
use Photoshop to create a completely seamless image. You can link layers together so that they
move as a unit, or you can merge them so they become one layer. If you want a layer to be
stored in its own file, you can easily export the layers in your image to their own file.

Using Auto-Align

Auto Al|gn is an excellent tool for lining up the layers in an image. !f you have a couple of
another, Photoshop can blend the two layers together into a seamiess |mage Or nf you want to
make an image out of several smaller images {for example, a panoramu: view that wouldn't fit
in one camera shot, but is broken up into a couple of shots) Auto Ahgn h lps you create the

Photoshop auto-aligns images by looking for. |dent[cai elements between the layers and using
that to calculate the relative positions of the aners You. .can choose which layer you want
Photoshop to match, or you can let Photoshop automat:caiiy decide what works best for the
layers in your image. i :

The Auto-Align Layers command is found on the Edlt menu, and will only be available to you if
you have selected more than’ one Iayer {To select multiple layers, click one of the layers in the
Layers palette, hold Ctrl, and cltck the addmonai layer(s). Make sure you only select layers that
need to be aligned.) : :
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After choosing Auto-Align, you need to select the method Photoshop should use to calculate
the alignment, as shown in the Auto-Align Layers dialogue box. There are four different ways
that Photoshop can do this:

Auto Photoshop deudes whether Perspective or Cylindrical is a better choice,

By U smg one: of the lmages as the base image, Photoshop transforms the
other lmages so that the common content matches. Photoshop may
transform the image in any way it needs, including skewing, stretching,
and’ repoatromng

Perspective

_:_hotoshop displays each image as an unfolded cylinder, and then
;:matches the content shared between the layers. it is particularly useful
for panoramas, as it reduces some of the distortion that perspective can

‘cause.

Cylindrical

Repositiononly  Matches the overlapping content, but does not transform any of the
images. This is useful for matching images with the same content, but
where one image is slightly offset from the other,

© 2010 Computrain Technical institute

26



Adobe Photoshop CS5 Intermediate 27

For example, we have the following three images, which are three shots of the same view that
the lens angle wasn’'t wide enough to capture in one shot.
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Here is the image aligned using the cylindrical method. Note how it is flatter and more even
looking.

Using Auto-Blend

When you take different images, layer them, and thén.align'them, you will ﬁi‘robably end up
with slight differences in exposure. This will look chunky;-and you will be able to tell that the
image came from more than one source. To f_i_;‘(";'thi__s,_we can:_l,_l_se"'AtithBlend. Auto-Blend
smoothes out the differences hetween the-s-]ay'ers, t'Hu__s creatir’ig__a seamless image. In the image
above, you can see the lines between the three images and the differences in exposure.

To Auto-Blend your layers, from the Edit menu, select Auto-Blend Layers, and then wait for
Photoshop to do its magic. Auto Blend can take a bit (_jf time, depending on your system and
the size of the layers. )

Here is the landscape shown aliove: fter uto-Blending. You can see that the lines between the
original images have disappeared and:the exposure looks consistent across the image.

Linking Layers

There may be times when you want to link two or more layers in such a way that they can be
moved around the image together without losing their individual layer qualities.
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To link layers, select the layers you want to link (using Ctrl + click), and then either click the link
tool at the bottom of the Layers palette, or choose Link Layers from the Layer or palette options
menu. When you click a layer that has links, a link icon appears beside it and any layers it is
linked to.

-s
i

e |k indicator

the Move tool is used when either of the:|
around the image window t{)’gethé"' You can also-apply transformations to linked layers.
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Duplicating Layers

When you consider that part of the reason we work with layers is because we do not want to
risk spoiling the underlying image, the following question arises: what do we do if we have
invested a lot of work into a layer and we do not want to risk spoiling it?

The answer is to make a duplicate of the layer you want to keep safe. This will let you try out
additional edits to the layer without altering the original.

The Duplicate Layer command is available on both the Layer menu and the Options menu on
the Layers palette, as shown below. :

.éhift+Ctrl+r~1

Mew Layer

Deiete Layer

Mew Sroup. ..
Mew Group From Lavers, .,

sl\

Layer Froperties...
EBierding Options. ..

Creake Chpping Mask AlA-CtrlG

Merge Du_:-_(-».'n" Chel4E
Merae Yisible Shift+Chel+E
Flatten Image

Animation Cptions
Palette Cptions..,
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Click the Duplicate Layer item in the menu to open the following dialogue box.

The default name is the original layer name followed by the word ‘copyit S|mply enter aname
for the duplicate layer and click the OK button to create it. If you want the' layer to become part
of another image file, make sure the file is open, and then choose the* i _‘from the Document
list. (By default, the destination that is specified WE“ be “tha
are duplicating.) :

When you click OK, the duplicate layer appears above the solrce Iayer in the Layers palette.
You may wish to avoid confusion and make the orrginal layer (the source of the duplication)
invisible by clicking the eye icon. Now: you can edrt the copy wuthout affecting the original layer.

You can also create a duplicate Iayer b'y‘ dra'gging and dropping the layer you want to copy down
to the new layer icon (just to;the left of the trash. can in the Layers palette). When you do this, a
copy of the layer will appearin the Layers palette list.

| Aower background

Drag laver over Newéwayer
ton] to create a copy
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Merging Layers

32

After you have worked with your layers, used adjustment and fill layers, and produced an image
to your liking, you may wish to merge some layers together. The more layers you have in your
image, the bigger the file size, and the slower the image is to work with. Merging layers allows
you to preserve your edits while reducing file size. When you merge layers, the image data in
the top layer takes precedence over any data in the underlying layers.

There are three ways to merge layers:

Merge Layers

Merge Visible Layers

Merge Down

When you have more than one layer seiected_ ou can choose
Layer — Merge Layers to merge the selected I"'_ ers.

Display only the layers you want to erge, :'and then from the
Layer or palette options menu choose Merge V|5|bie “This is a good
way to see the resultant er; jill be the, only visible layer.

To merge down, you_.‘ ‘nly need to:select.one layer, and then from
the Layer or Palette Opt|ons menu choose Merge Down. The layer
will merge with: t_he Iayer-'mmedlately below it.

As well, you can flatten your image by choosmg Fiatten Image from the Layer menu. Flattening
converts the image to a single iayer meanmg afl of the layers are merged onto the background.
Flattening is a permanent change to youf-lmage and WIiE be discussed more in Lesson 3.4.
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In our flower image, we have two linked layers — Sunflower 1 and Sunflower 2. By making them
the only visible layers, and then choosing Merge Visible from the palette options menu, we can
merge the layers.

Mews Layer, SR
Duplicate Layer..,

100156 Dielete Lansr
Delete Hidden Layers

fdew Group,..
Few Group From Layers...

Corret o Smart Oi:-j&'-l:t

o

Layer Properties, .
Elending Options. ..

‘Create Clipping Mask AlkA-Chr G

Select Linked Layers .

Firge Down Chrl+E -

latter Inage

Anirnaticn Cptions
Palette Options

After merging__;’_czgﬁ'e"' l"a"ye_fg,'WetzljaVe.dpe less layer in our image. The top layer no longer exists;
the new layer retains the name of the bottom layer.
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Exporting Layers

. gdm lmage "
Me, ., [y RN
Cpren,., Chrl+C
Browse, ., AlEACEr O
Cpen As.,, AlA-SHF T+ -0

Dper As Smart Object, ..
Cpen Racent

Device Central,,.

SEFIEY

il i H

Close and Go To Bridoe... Shift+Chrl444¢

Save ChrM-5
Save Bs,,, Shift-+Ctrl-5
Check In...

Save For Web & Devicas. ., At Shife+-Chrls
Reseert Fiz
Flace, .,

Import

Export

You can create a file out of a fayer in an image by exporting it. When you do this, each layer of
the image becomes its own file. To export your layers, run the Export Layers to Files script from
the File menu.

Image Processor, ..

Layar Comps to Files, ..
Layer Comps to PDF...
Laver Comps to WPG,,.

File Infa...

Page Setup, ., SHIFE+Chr4-P

Frink... Chrl+P

Prirt Qe Copy Alb-+ShifE+Chrf-P

Exik Chr4-G y
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Script Everits Marager., .,

Load Files inkn Stack...
Load Multiphe DICOM Files, .,
Shatistics, .,

Brosess, .,

Then, using the dialogue box shown below, choose a file name prefix for the layers, the folder
in which you want to store the files, and the file format.
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|2 Canicel

Rleaze specify t gt and ocaticey for saving each layerzs

The resultant file names will be the pre x followed by a four digit number based on the layer
order, and then the Iayer name The result of exporting the four layers in the Flower image is
this list of files: : :

% HD!,“\'EF__.UEIUOI_UHE:.QSC!

T Flower, 0001 Levels 1. psd

§ i Flower_T00Z_Sunflower 2.psd

BN Flowsr 00073 Flower Barkground.psd
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Section 1: Review Questions

1. What is a layer?
‘ A duplicate of an image
B. A type of channel
C. A virtual plastic sheet that can hold a selection, an image, or an effect, and that can

be stacked one on top of another
D. Any of the above

2. Which of the following is true?
There are at least three ways to create a layer.
There is only one way to create a layer. .
You cannot create a layer. You must use pre- eXIStmg Iayers onl
None of the above.

o0 w»

3. How do you hide a layer from view?
Double click on the layer

Click the layer’s eye icon to make it ppear " :
Drag the layer to the hide button' at the bottom of the palette
Choose Hide Layer from the Edlt menu

COwr

4, What does “adjusting a iayer s opauty” mean?
Adjusting the level of biack inthe fayer -

Adjusting the level‘_" fsatu_r ion in the’ layer

Hiding a layer &

Altering the- transparency of the dayer

Any of the above T

mo N w e

5. Why i is the order of your Iayers in the Layers palette important?
LEWith layers, ord:er is‘not important
The iowest Iaye s in the palette will be seen on top of the highest layers in the

. palette
C.  “Nolayers beneath the top layer will ever be seen
D. The,__tqu_._layer will be seen, and if it is only partially covered, or if it is transparent, the

visible parts of underlying layers can be seen as well

6. What is the effect of layers on file size?

Keeping the separate layer information intact makes your files larger
Preserving your layers does not affect file size

Preserving your layers decreases file size

You cannot preserve separate layer information

OO w e
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10.

N s

OO PR

=

What is an adjustment layer?

How do you put a selection on a Iayézﬁ

What do you call the process of creating an image out of two or more slightly
misaligned images?

Auto-Align
Auto-Blend
Create panorama
Stack

Auto-Blend adjusts for differences in:

Hue
Saturation
Exposure
Position

An adjustment layer is a layer that has had an edltmg ffect appised to it

An adjustment layer is a layer that contains a:mask assoc:ated With ‘a particular kind
of image adjustment : i

There is no such thing as an adjustment Iayer in Photoshop CSS
None of the above i

Layer ~ New — Layer via Copy..
Layer — New — Layer viaCut.
Image — Add Selection to Layer
AandB :
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Section 2: Retouching Images

L ds R

In this section you will {earn about:
*  Retouching
» Hue and saturation

In this section you will also learn how to:
¥ Use the Blur tool
»  Use the Sharpen tool
*  Use the Smudge tool
= Use the Dodge tool
* Use the Burn tool
*  Use the Sponge tool
*  Work with hue and saturation
= Work with brightness and contrast
*  Work with shadows and highlights
* Use the Healing Brush
» Use the Pattern Stamp
= Use the Clone Stamp
s Use the Patch tool

© 2010 Computrain Technical institute
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Lesson 2.1: Working with Retouch Tools

One of the most common uses for photo editing software is retouching images. The broad
selection of powerful retouching tools that Photoshop provides makes it one of the best
choices for this kind of work. Photoshop has the tools you need for removing blemishes,
enhancing color, and almost everything else in between. With Photoshop, your digital images
can be artistically enhanced, altered, revitalized, and repaired to a state that is arguably better
than the original. .

In this lesson, you will learn about retouching images. You will also |earn__how to use three
Photoshop tools intended for retouching and enhancing images: the Blurtool;the Sha
and the Smudge tool. Keep in mind that retouching images is as much'an artas it is a science.
Use this lesson to learn about these tools, and then refine thelr use wath exper!mentataon and
practice. ‘ : : :

What is Retouching?

Retouching is the process of emphasizing, removmg, -adding, or enhancing elements in an
image. These elements can include people, shadows color structures, or blemishes. Images
can be retouched to improve their general appearance to: create emphasis, to focus ona
particular region of the image, or for reason_s of al’tIStEC express:on

With Photoshop CS5, there are mé'ny ways yoLj"tan re’touch any given image. What tools you
use and what approach you take W!H vary from image to image, depending on the end result
you have in mind. Photoshop has a. number of stamps, brushes, brightness, color controls, and
other tools that give you alot of: flembalrty when it comes to retouching. If you have a pretty
good idea of what you want your want your digital photo to look like, more often than not

Photoshop ca_rg‘_.help you achg_eve the desired results.

The Blur Tool

The Blur tool is used. to soften edges and other areas of high contrast in an image. Some users
might use 't‘:hé-._.g_lyr.t_(}fol to create an out-of-focus effect, while others might use it to
deemphasize unwanted harshness or contrast. You can also use the Blur tool to soften and
blend artifacts left by other image edits, like removing or adding objects or using the Stamp
tools.
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To use the Blur tool, first select it from the toolbox.

Determmesthe size and shape of the brush used to apply the
blurring. "

':55-_:an-tfi_;6|s exactly how the pixels are affected by the blurring:

"= Normal produces a consistent result, changing each pixel in
the same way

» Darken paints with the darkest appropriate pixel in the area;
has a greater effect on lighter pixels

» Lighten paints with the lightest appropriate pixel in the area;
has a greater effect on darker pixels

* Hue results in the same luminance and saturation with which
you started, but adjusts the hue (shade of color)

= Saturation results in the same fuminance and hue with which
you started, but adjusts the saturation {vividness of color)
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»  Color results in the same luminance with which you started,
but adjusts the hue and saturation

» Luminosity results in the same hue and saturation with which
you started, but adjusts the luminance (level of tight)

Strength The degree to which your pixels will be affected.

Sample All Layers  If checked, the colors of all layers will be taken into account as
Photoshop calculates the changes it makes to each pig(_el.

Finger Painting If checked, blurs with the foreground color.

In thisi |mage the stems stood out very sharply. Using the Blur tool we an soften it:The left
1age, you can
see that they have been softened =

The options for the Sharpen tool are the same as those for the Blur tool, so you can refer to the
table above for a full explanation.
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In this image, some of the petals’ edges have been sharpened:

605
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Lesson 2.2: More Retouching Tools

R A G e A SR

in the last lesson you were introduced to some of Photoshop’s retouch tools: the Blur tool, the
Smudge tool, and the Sharpen tool. In this lesson, we will continue to explore retouching tools
with discussions of the Dodge tool, the Burn tool, and the Sponge tool.

The Dodge, Burn, and Sponge tools differ from the tools in the first lesson in that they produce
direct effects on the color tones of your image. These tools lighten {dodge};darken (burn}, or

intensify (sponge) the color values for the areas that you drag your mouse p"o'ir};er over.

The Dodge Tool

Using the Dodge tool is similar to using the tools we’ve already covered. Click the tool on the
Toolhox, set the options in the Options bar, and apply the dodging to the image.
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With the Dodge tool, however, there is an option called Range that the previous tools did not
have. You can use the range drop list to select what kind of color tones will be altered:
shadows, midtones, or highlights. Instead of setting the Strength, as we did for the Blur tool and
its variants, we set the Exposure which adjusts the intensity of the adjustment.

gei Midtonss

Shadows are the darkest parts of your image, while highlights are the lightest parts of your
image. Midtones comprise the large range of colors in your image that are lighter than the
shadows, and darker than the highlights. With the Dodge tool, you cannot fighten all tonal
ranges with a single stroke of your mouse pointer. Instead, you must selett the partlcular range
you want to modify and then drag your mouse over the area you want to hghte '

With the Exposure slider switch, you can adjust the intensity o } power of the hghtenmg effect
of the Dodge tool. Basically, if the exposure value is higher, the Ilghtenmg effect will be
stronger. Use caution when using the Dodge tool w:th'a hlgh exposure alue: If the exposure is
set to a high value, a single stroke with the mouse: pomter can r_nake a drastic difference in the
image. It is normally best to work with low exposures (5% <15%) and smaII te moderate brush
sizes, but this will depend on the effect that you are trying to chieve. If you want to create the
effect evenly over a larger area, use a Iarge br sh size’ (60 plxeis) with low brush hardness.

In this example, the shadow unde; h__e Séuc;er has bj__e_en iighf'ened slightly using the Dodge tool.

If you click the airbrush button (the button with the pen symbol on it) at the right of the
Options bar, you can hold your left mouse button down and the spot beneath your mouse
pointer will continue to lighten. If this button is not on, you must click your left mouse button
to lighten the spot your pointer is over incrementally.

© 2010 Computrain Technical institute




Adobe Photoshop CS5 Intermediate 45

The Burn Tool

The Burn tool is the opposite of the Dodge tool. The Burn tool will darken the regions you drag
your mouse over, whereas the Dodge tool lightens them.

To use the Burn tool, first select it from the toolbox.

nd your exposure

To create a burn effect, drag your mouse pointer (brush tip)over the region of the image that
you want to darken. Be careful when using the Burn tool as its effects can be quite pronounced
when you use a high exposure setting:.Jo start, choose asmall to moderate brush size and a
low (5% to 15%) exposure setting. To distribute the effect evenly over a larger area, use a larger
brush size with a low hardness setting:“As you are working, you can use the { key to decrease
the size of your brush, and the ] key to increaseit

In this example, the teacup onthe right has had its pattern enhanced by darkening the purple
flowers. ‘ '
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The Sponge Tool

The Sponge tool, which is located in the group with the Burn tool and the Dodge tool, is used to
increase or decrease color saturation.

Desaturate

You can use the Flow slider switch to control the strength of the Sponge tool's effect. Higher
values strengthen the effect, and iower values: weaken it: To begin, use a lower flow setting.
Remember, you can always repeat your strokes to. make astronger effect as an alternative to
increasing the flow value. :

As with the Burn and Dodge: tools use sma!l brush sizes for detailed work, and larger brush
sizes for large, evenly blende ér

Do not confuse the results from ihe Desaturate setting for the Sponge tool with the results
produced by the'Dodge tool The Sponge toof desaturates color, that is, it makes the color less
pure or intense. The Do,dge top_l affects the lightness of the color.

After you select the Sponge tool and set up its options, you can create your desired effect by
draggiﬁg YOUr Mouse; pointer over the specific region of the image that you want to saturate or
desaturate itis probably best to start with a lower flow value until you become accustomed to
usmg the Sponge tool Again, you can use [ to decrease the size of the brush, and ] to increase
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In this example, the lighter purples have been brought out more by saturating them with the

Sponge tool.
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Lesson 2.3: Working with Color, Brlghtness, and Contrast

in the preceding lessons, you learned how to apply retouch tools to specific image areas. You
used the retouch tools to enhance tonal ranges by darkening or lightening them, and you
learned how to use the Sponge tool to saturate or desaturate the color in a specific area. These
are not the only ways to work with light and color, however. Photoshop also provides tools for
working with color and brightness that are more global in nature. In this case, the changes are
applied across the entire image, not just localized areas that you drag or cii_g__k__ over.

In this lesson you will learn about hue, saturation, and brightness. You will learn how to use the
Hue/Saturation dialogue box, as well as the Brightness/Contrast dialogue: ox. Yo
learn how to manipulate shadows and highlights using the Shadow/Highilg -..dlalogue'

What are Hue, Saturation, and Brightness?

As you probably already know, colors on your compu er.scre n canbe described in terms of
their red, green, and blue components. By Mixing. these le _:eis of these icolor components you
can generate millions of different colors. An ther | way to look at color is in terms of hue,
saturation, and brightness. . f

Hue refers to how we perceive the dommant wavelengths of a color source. It is the
characteristic we are describing: whe 'we refer toa color as green, or purple, or red. You could
think of hue in the same way:that you think of shades or tones of color. Some people use the
word hue in the same way they would sé the word color.

Saturation refers to how we perceu e}the ratio of the dominant wavelengths to all the other
wavelengths of a color source_-._: ) other words, saturation can be described as the strength or
intensity of a shade or toneof co o'r A color that is very saturated will appear strong and vivid
to our eyes, whrle a color that is, much less saturated can appear to be washed-out or weak. A
color that is completely desaturated will appear as a shade of gray.

Br:ghtness refersto how'we' perceive the amount of light energy given off by a color source,
People often think of brightness on a scale from dark to light, with black having very little
brightness {light: energy) and white having maximum brightness.

As it turns out, any of the colors that can be described in terms of red, green, and blue values
can also be described in terms of hue, saturation, and brightness values. Some people find that
the hue, saturation, and brightness scheme is a more intuitive and natural way to view color
than the RGB scheme.
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Working with Hue

If you choose Image — Adjustments — Hue/Saturation from the menu bar, you will see the
following dialogue box.

When you are working with hue: and saturatlon you can control the master setting for all
colors, or you can work on an mdtwdual_channel Red Green, or Blue, or Cyan, Magenta, or
Yellow. This selection is made fr m the Edit fist.

When you are work:ng fo the master aII colors in your image are affected by your adjustment.
Moving the hue sIJder changes the. hues {shades of color} in the active image. (Notice that by
default, the slsders are ata ieve] ofzero ) If the checkbox labeled Preview is cleared, you will not
see the adJustments you._,__ ake refiected on the image. If you put a check in the Colorize
checkbo_x, you can create a_colonzed version of the image similar to grayscale (like sepia tone}.
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Here is an image that has had the hue adjusted. The image on the left is the original:

Fall off limits ~ Colorrange
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The color range sets the colors to be affected by the adjustment. The bar at each end of the
range can be adjusted, or you can siide the whole range by clicking on the gray between the
bars. If you slide the bar so far that you are into another color range, the Edit list changes to
reflect this. The fall-off limits set the color at which the adjustment feathers instead of being a
sharp change. As you move the sliders, the percentage values for each color wheel display the
current setting.

Once you have made all of your setting, click OK to accept them. These new settings now
become the basis for further changes: the values in the Hue/Saturation dzalogue box are reset
to zero, and changes are relative to your current settings.

Working with Saturation

Saturation is changed using the same dialogue box as hue. Ad;ustlng the saturatlon controls
how vivid the color is. Technically, saturation measures the: amount Q__-gray in proportion to the
hue. Increasing the saturation results in a positive. e‘rcenta 3 Converseiy, to decrease the
saturation, or make the color more dull, move th sllder he' left of 0. Here is the teacup
image with the Master saturation set to +60 the: eft and’ '.40 on the right. You can really see
the difference in the vividness of the color.

If you Want 10 just adjust the saturation of one color channel, choose the color from the Edit
list, the same as:working with Hue.
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In this image, only the blues are adjusted to +60. You can see that the croissant and teacup
aren’t as vivid; it’s mostly the background that has been changed.

If you would like to keep a given set of adjustments, you: ‘¢an savethe ._on iguration by clicking
the Save button in the dialogue box. If you would like’ to load ‘a saved configuration, click the
Load button, :

To desaturate your entire image so that all color is removed, and your image appears in shades
of gray, select Image — Adjustments — Desaturate.

Working with Lightness

The final setting in the Hue/Saturation dialogue box is the lightness setting. Lightness refers to
how much white is in the color — 100% is pure white, and 0% is pure black,
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This image had a nice amount of light to start with, so you can see that when we increase the
light in it to +40, it starts to get a washed out look. Again, once you are satisfied with your
settings, click OK to accept the changes.

Working with Brightness and Contrast

Brightness and contrast affect the tonallty of your imag .'.These adjustments should be made
on a layer, not on the original i image, as they resultin the permanent loss of some image
information. You can manipulate. the bright'- ess and contrast for an image by choosing Image —
Adjustments — Bﬂghtness/Contrast The"'d_lalogue box is shown here:

Here you can use:the slider switches to adjust the tevel of brightness (light or dark) and the
level of contrast in the image. Contrast can be described as the differences in color and light in
an image that helps to distinguish the image’s various elements. You can enter values directly in
the value fields provided if you wish.
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In this example, the image on the left has been brightened and had the contrast increased:

as you make them. This way,
them.

As with the Hue/Saturation dialogue box, pressing the Alt key lets you toggle between Reset
and Cancel. If you click the Reset button, the sliders will be set to the defauit positions at a level
of zero.

When you are satisfied with your brightness and contrast adjustments, click the OK button to
implement the changes. Keep in mind that this method of configuring brightness and contrast
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applies to the entire image, so you have no control over how isolated these effects will be using
this method.

Working with Shadows and Highlights

You have already seen two retouch tools that can be used with shadows and highlights: the

Dodge tool and the Burn tool. Although these tools can be applied to specific areas of an image,
Photoshop CS5 provides a Shadow/Highlight dialogue box that can be used to modlfy shadows
and highlights for the entire image at once. :

To adjust the shadows and highlights for your image, choose Image = /
Shadow/Highlight from the menu bar. You may notice that th:e__:i__magé*iﬁ)u aré*'mod:fymg
changes slightly. This is because the Shadow/Highlight commé:rfi;_é_l:adjusts the |mage to a default

There is a sllder for controﬂmg the shadows in your image and a separate slider for the
hlghi|ghts ifyou mcrease the shadow slider to a higher percentage, the shadows in the image
will hghten possibly. reveakng more underlying detail. If you move the slider the other way, to
decrease the amoun ; the shadows will darken.

If you increase the Highlight amount to a higher percentage, the highlights throughout the
image will darken. If you decrease the Highlight amounts, the highlights will lighten.

If you wish, you can enter values for Shadows and Highlights directly in the fields provided.
As before, you can use the Alt key to make a Reset option available {(meaning the Cancel button

will display the word Reset when the Alt key is pressed). Clicking Reset will restore the image’s
original values.
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The shadow and hightight controls are great for correcting over or under exposed images. You
can also use these controls effectively to balance or tweak light and shadow in practically any
image.

Adding some shadows to the spider web realfly makes the web stand out nicely:
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You can get finer control over highlights and shadows by clicking the Show More Options
checkbox. When you do this, the dialogue box will appear as follows:

Now with the é'kpé":n'ded options, you can see two additional sliders: Tonal Width and Radius.

The tonal width is the range of values that will be adjusted with the sliders. For example, a
small tonal width setting for shadows would mean that only very dark regions will be affected
by the sliders, Basically, if you move the tonal width slider to the right (for either the shadows
or highlights) more regions of the image will be affected with changes to the shadow or
highlight amount values. if you move the tonal width sliders to the left, fewer regions will be

affected.
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The radius sliders control the physical area of the pixels that are affected, based on location {as
measured in pixels) rather than relative lightness or darkness.

How you adjust the Radius sliders and the Tonal Width sliders will depend on the image you are
working with and the end results that you are after. In general, you will probably want your
radius values to be between 30 and 60 pixels to start, but feel free to experiment.

As for the tonal width values, first set your shadow and highlight amount sliders until you are
satisfied with the results. Then adjust your tonal width sliders, watching cafe"fully to see how
they change the appearance of detail and light in your image. When you are happy with these
adjustments, you may want to go back and tweak your Radius values to see |f you can uncover
any additional detail. :

You can use the Color Correction slider to compensate for loss of color due'to the shadow and
highlight adjustments. Areas of the image that were not: adjusted should not be affected by the
Color Correction values. You can also add contrast to' h'e mldtone's 'f"'an image with the
Midtones Contrast slider if you wish.

As always, you can enter values directly in the leids prov&ded if you prefer not to use the
sliders. If you wish to save a particular group of settmgs use the Save button. To load a saved
configuration, use the Load button. If you chck the OK button the adjustments you made will be
implemented in the image. .

If you wish to revert to the condensed versuon of the’ daalogue clear the Show More Options
checkbox. :
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Lesson 2.4: Retouching With Stamps and Brushes

A T R

Even though we have learned a lot about adjusting an image, there is still another group of
tools that play an important part when it comes to retouching images: the Stamp tools and

Healing Brush tools.

In this lesson, you will learn about the Healing Brush and the Patch tool. You will also learn
about the Clone Stamp and the Pattern Stamp tool. These tools can be extremely helpful when
retouching images and they are easy to use. '

Unlike the retouch tools in the previous lessons, the stamp and brush tools that foilow are used
primarily for removing, blending, or covering up blemishes or other unwanted elements These
tools are fun to use, and they can produce amazing results. : :

The Healing Brush

The Healing Brush works by borrowing or samphng smage mformatfon"from one spot, and then
using that information to neatly cover or repasr an unwanted blemlsh or region in another area.
The Healing Brush gets its name from its ability to blend (heal) the texture, shading, and color
of the borrowed data into its new dest:nation. :

The Healing Brush is the tool tha’fc'fftiéké;_l;i ké‘-’a_;;banda'ée:

When you select the tool, the Options bar reflects the settings you can make for the healing
brush. You can choose the size and hardness of your brush and the mode in the same way you

have for other tools.
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However, there are three additional settings for your brush: the spacing, the angle, and the
roundness.

Pen Prassure

Spacing
Angle

Roundness

The options for the Healing Brush include a couple that we haven’t yet seen.

Zouree Dampled Opatans | [ Dldloned | Supler | cunent L

Before using the brush, set your source: you can take a sample of the image that you want to
transfer to the damaged or blemished area, or you can select a pattern to ptace over an area.
You will also notice a checkbox labeled Aligned. If this is checked, the sample area that is used
as your source will move uniformiy with your mouse pointer when you drag it around the
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image. If Aligned is deselected, the sample cross hairs will return to the original spot you
sampled whenever you release the left mouse button.

To use this tool, select it, set your options, and then take the sample that you are referencing
by pressing Alt and clicking. Then begin clicking where you want to repair or change your image.
Readjust the brush and options as needed until you are happy with your results. Remember,
you can use the square brackets on your keyboard to adjust the size of the brush as you work.

In this image, you can see a blemish on the grape in the left image. Using the healing brush, we
can improve the appearance of the grape.

Sometimes the edges of your repairs are difficult to control properly. You can solve this
problem by making a careful selection around the area you are healing. When you use the
Healing Brush close to the edge of the selection, the selection will keep the brush strokes inside
the border.
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The Patch Tool

The Patch tool is a variant of the Healing Brush.

There are two approaches to using this tooI‘f"":Sei__gectiné"'fh:e Source or seiecting the Destination.
You can decide which approach to use on the Options bar::

If you start by selecting the Des matio button on the Options bar, you will use the Patch tool
as you would the Lassotool, and select the: area of the image you are going to use as a patch.
You can add to or subtract from the selection by using the buttons on the Options bar as you
would for any;; select[on On_ce'yo | are satlsfled with your selection, simply drag the patch over
the area you want to repa|r
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In this image, the mud flap was removed using this method — an area of the asphalt was
selected as the destination, and then it was dragged over the mud flap. You can see that a bit of
editing work would still need to be done, but the bulk of the task is completed with this tool.

is option, the
the selection

, and release the left
Il be filled in and blended

border over. When you drag the dashed selection border.into.pos
mouse button, the area where you originally made the selectlon
with the region that the selection border has been moved to.

If you are using the Source option, yodf‘*mouse p’binter will:look like a small patch with a curved
arrow pointing into it. If you use the. Destmatson optlon your mouse pointer will look like a
small patch with an arrow pomtmg out of it
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A final option is to patch using a pattern. Select the area you want to patch, click the Patch tool,
select the pattern from the Options bar, click Use Pattern, and then drag over the area to patch.

Currenit Laryar

Here we have chosen a pattern that does not match the car for illustration purposes.

The Clone Stamp

The Clone Stamp tool is a lot like the Healing Brush tool, except that the Clone Stamp does not
automatically try to heal or blend the sampled image data into its new surroundings. The clone
stamp is great for removing small blemishes or unwanted objects from your image. The quality
of your cloning is dependent on your sample, so select it carefully.
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it. Each time you click your mouse, the cross halrs ndicate the source of the cloned pixels. You
can also simply click your mouse on the i 1mage_ fo depo it the image data onto a single spot the

size of your brush.

In this image, the Clone Stamp has béen u'§éd to remove the letters from the pink heart (beside
the yellow one). '
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When you select the Clone Stamp tool, its configuration options will be available in the Options
bar as shown.

; ; Currant Layer i

You can change the brush qualities (such as size and hardness) with the Brush options and you
can specify how the color is blended with the options available in the Mode drop list. You can
use the Opacity slider to adjust the transparency of the data you are cloning. If the setting is
close to 100, the data will be opaque. If the setting is close to 0, the data WI” be almost
transparent. '

You will also notice an Aligned checkbox at the left of the Options bar Thi ‘ChECkbOX_IS critical
to how the Clone Stamp tool works because it determines the source’ plxels 1f. .you ‘don’t select
Aligned, the source sample is always the one you originally Alt-clicked on. No matter where else
you click in the image, it always stamps it with the same pixels

If you select Aligned, the source pixels change as you nove your mouse. When you first sefect
your sample by Alt-clicking, and then use the cl ne stamp;.you'det rmme the relative distance
between the sample and destination. From that pomt on, every time e Yyou move your mouse and
click or drag to use the Clone Stamp, the source changes It moves along with you and you can
tell where the source is by the cross-hairs Sinceyour source is always changing, this is a good
way to actually clone an element of yourimage

You can use the Options bar to choose whether your sample should include only the current
layer, the current layer and all layers below, or all layers. If you want to ignore the adjustment
layers when sampling, click the button to the right of the Sample list.

Sampfvé Current Laysr
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As with the Healing Brush, you can use the selection tools to create a border to confine your
paint strokes. If you need to clone from more than one sample, you can use the Clone Source
palette. This palette adds functionality to Clone Stamping, notably the ability to store up to five
different sources for stamping. You can set up your sources, and then keep the palette close by
and select whichever sample you need. To display the Clone Source palette, select Window -
Clone Source. When you click one of the five source icons across the top, it either displays the
source information, or is empty and therefore available to store the next sample.

_Store up ‘izs.:} ﬁva smmes
for eagy access

The Pattern Stamp Tool

The Pattern Stamp is not reaHy a __etou'__ tool in a strict sense, as it is used to apply graphic
patterns to an image with pamtmg strokes {not usually appropriate for retouching digital
photos) it can be extremeiy usefui for certam special effects, however, and because of its

To use the Pattern Sfamp, first select it from the Photoshop toolbox. When you select it, its
options will be displayed the in the Options bar.
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You have already seen most of these options in the tools we have looked at. You choose your
sample from the pattern fist, shown below. Also, the Impressionist checkbox gives the pattern
an impressionist look by painting smudged dabs rather than a solid pattern.

splayed inthe

You can choose a pattern from this palette by clicking on it, a
n image, the

Pattern preview box in the Options bar. If you drag your mous
selected pattern will be painted along with your stroke,.

As with most p nting or. stamp too s, you can make a selection or inverse selection with one of
the selection tools, and then pamt inside the selection. Your paint strokes will be confined to
the selected area
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In the image below, several things have been done. First, a custom pattern was created from a
different image (the teacup we have seen previousty). Then, a selection was made by using the
Quick Selection tool to select the cup, and then inverting the selection. This ensures the cup
and foam are not accidentally covered with the stamp. Finally, the Clone Stamp tool was
applied with a large brush to produce the final result.
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Section 2: Review Questions

1. The purpose of the Blur tool is...
To soften edges in an image
Te harden edges in an image
To smudge selected regions
Any of the above

o0 w®»

2. In Photoshop, the Sharpen tool is grouped with...
The Dodge and Sponge tool

The Burn tool and Gradient tool

The Blur tool and Smudge tool

The Pattern Stamp tool and Clone Stamp tool

on® >

3. What is the purpose of the Sponge tool?
To saturate color

To fade color

To decrease contrast
AandB

O N w

4. Saturation is a word that describes
Wetness of a color
Darkness of a color
Vividness of a colot
None of the above

the

O wm e

5. You can adjust the shadows and highlights in an image by using which menu
Image ~ Adjustmerits — Shadow/Highlight
Edit = Shadows/Highlights

Image +=Mode — Darken/Lighten

None of the:above

Do @ e

6. Which:of the following is not a retouch tool?
The Dodge tool

The Move tool

The Clone Stamp

The Patch tool

oN® P
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7. The Healing Brush is very similar to the ...

Clone Stamp tool

Sponge tool

Zoom tool

There is no such thing as the Healing Brush tool

U OE e

8. The Pattern Stamp tool is grouped with...
The Patch too!

The Blur tool and Sponge tool
The Clone Stamp tool

None of the above

All of the above

mE O w e

9. Brightness and contrast affect the...
Tonality of your image
Hue of your image
Saturation of your image
None of the above

o w e

10. What is retouching? i
Correcting light and shade inan image

Adjusting color saturation in‘an image:: .
Removing lmperfectlons and biemlshes from an lmage
All of the above : ;

0 ®»r
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Section 3: Getting Creative

in this section you will learn how to:
= Use the Paint Bucket
* Use the Paint Brush
»  Work with custom brushes
= Use the Airbrush
» Use the Pencil tool
»  Work with horizontal and vertical type
v Perform a spell check
» Use the Character palette
=  Work with lines and shapes
= Use pens
* Create and manipulate paths
= Use and undo rasterization
» Flatten the image
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Lesson 3.1: Working with Brushes

R e e D A et

You already know that several Photoshop tools can be applied with brush strokes. Tools like the
Healing Brush and the Clone Stamp, and the Dodge, Burn, and Sponge tools, are all applied with
the tip of a digital brush. What you may not have seen is the variety of options Photoshop

provides when it comes to brushes and painting.

In this lesson, you will become familiar with the Paint Bucket (fill tool), the _sjt:‘endard Brush tool,
and the Pencil tool. You will also learn how to use the Airbrush feature and how to work with

custom brushes.

As you have seen, there are a multitude of Photoshop effects and features hat ca Eé_?'applied
with brushes. If you learn how to get more control over your brushes, you W1|| also be learning
how to get more control over these effects and features. = *

Using the Paint Bucket

The Paint Bucket, also known as the Filf tool __IS used to fi” a canvas a Iayer or a selected area
with color by clicking in it. It wilt replace all pixels that are the same or close to the pixels that
you click on, based on a tolerance thatiyou can spemfy

The Paint Bucket is grouped with the Gradlent tool, but it is used to apply an even coat of color,
where the Gradient tool is _used to apply a geometncally changing color effect (a gradient).
When you sele.c___tkt_he‘_Pamt “Ck.e_g lk-_the Options bar changes to reflect the relevant options:

zontigols 2]

Foreground

Before you can pamt ‘you'need to decide what you will be painting with. If you are painting
with a color _make sure Foreground is chosen on the Options bar, and set the foreground color
to the color you: want To paint with a pattern, choose Pattern instead of Foreground. Set your
Mode and Opauty, and then click the color you want to replace with the new color. if you want
alt of the color in the whole image to be replaced, make sure that you have Contiguous
deselected on the Options bar. If you want to color all layers, select the All Layers check box.
Set the tolerance to determine how wide a range of color will be replaced (the higher the
tolerance setting, the more pixels will be recolored).

Once you have the Paint Bucket set up, click in the image to paint it. One click might not be
enough to recolor everything you need; sometimes you will need to click in several focations.
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Remember that you can use the History palette or Undo to step back, tweak your settings, and
try again until you get it right.

Here is a before and after look at the sunflower image with the background darkened to a navy
blue:

Using the Brush.

Using the Brush tool is an important part of working with Photoshop. First of all, a variety of
Photoshop tools are applied with brush strokes, and learning to manipulate your brushes will
help you to manipulate these other tools. Secondly, learning how to manipulate your brushes
will give you more power and flexibility when it comes to actual painting or adding color to your
Photoshop images and creations.
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First, select the Brush tool from the toolbox.

You will then see its configuration options appear in__thé’f:?ép.tions ar.:

Choose a brush preset, or manually set the options for your brush and then click and drag over
your image. The brush preset pncker_ contalns the' settmgs for the size and hardness of your

stroke will be,

The brush paints with the current foreground color, so make sure you have set it to your
desired color. To get a perfectly straight line with your brush, click on your image canvas at the
start point of vour stroke, and then Shift + click at the point where you want your stroke to end.
The stroke will be painted in a straight line from point to point.
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As an example, take a look at the following Photoshop canvas with varying brush strokes:

Q P:":s ’§ ﬂ{p%hardne%

. 21 px, 50% hardness |

e 45 P, 0% hardness.

Brushes can be further varied by changing the_;pamtmg mode For'examp!e here is a brush
stroke painted with the Dissolve mode:

Experimentation is the best way: to see the range of brush choices you have, and to determine
what will best meet the '____eds ofa glven situation.

Working with Custom Brushes

if you ca__f'n’t get the"Blgu__shfy_c_)':u want by working with the presets and options, you can use part
of an image to create a brush from scratch. This means you have an endless variety to the
brushes youcan create.
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For example, we can create a brush based on the bubbles in the fish picture, and by working
with the Brushes palette, can create a brush that paints bubbles onto the image.

To accomplish this, simply select the part of the image t_h_a_t__you want asiyour brush, and then
from the Edit menu, select Define Brush Preset. In the Brush:Name dialogue:box (shown below)
name the brush and click OK. '

Bubblel
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Then, use the Brushes palette to modify the brush as you wish. (You can turn the Brushes
palette on by clicking the icon at the right side of the Options bar, or by selecting Brushes from
the Window menu.)

Based on a bubble
from the fish image

The bru h will be ___:ailabiei'f:':b all images, not just the source image.

Using the Ail

The Airbrush will apply gradual tones, appearing as a softer stroke that can appear faded or
dark depending on how long you hold your mouse button down over the canvas. A quick stroke
can have a different effect than a slow steady stroke. This color intensity of the stroke can be
controlled with the Flow slider.
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To start using the Airbrush, click the Brush icon in the toolbox. Then, click the icon next to the
flow slider on the Brushes Options bar.

Toggles Airbrush

A single click with the flow set low will apply a faded dot. A single click with:the flow set high
will apply a strongly colored dot. As you hold your mouse button down,.the color will gradually
intensify depending on the flow setting. :

Above are three dots, each created from a smgle cI|cI< with a brush set at 30 pixels wide and
100% hardness. For the first dot, the ﬂow was set at 10%, for the second the flow was set at
50%, and for the third and final dot, the flow was set at 100%.

Airbrushes can be used effectively.to apply hght and shadow to an image, often through a
mask, as discussed in Lesson 4;

Using the Pencil Tool *-

is groupedWith %he:B__rush tool in the Photoshop toolbox.

Bxush TGul
F‘unul T-::c»i o

s:}' Col-‘-r Repiahemenl ‘]'vL‘-ﬂ '__::
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The Options bar for the Pencil tool is very similar to that of the brush:

opatity ] 1009

ormal

Note that there is no airbrush option for the pencil, as the pencil is intended to produce hard
lines. There is, however, an Auto Erase option. If this is selected, you can paint with either the
foreground or the hackground color. If the cursor is over an area containing the foreground
color when you begin dragging, the pencil paints with the background color:: if the cursor is over
any other color, the pencil behaves normally, and paints with the foreg_r_o nd co_i_Qr.

The Pencil tool operates in a way that is almost identical to the Brush tool, exceptthatthe
Pencil tool gives you harder and crisper edges. To use the Pencil tool you normally select the
foreground color that you want to draw with, and then specnfy our-pencnl diameter and
hardness in the exact same way as would with the Brush tool.

As with the Brush tool, there are settings for blend:*md'élg and opacity available in the Options
bar. :
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Lesson 3.2: Using Type Tools

e e S ]

Although Photoshop is designed primarily for bitmap image processing, it contains a very
comprehensive and functional set of type tools. You can use these tools to add titles or
headings to your images, or to create your own text-based graphics from scratch.

In this lesson you will learn how to work with horizontal type and vertical type. You will learn

how to modify your typed characters, and you will learn how to work with the Character
palette. 5

Working with Horizontal Type

Horizontal type runs from left to right across your image. The"Horizontal Type tool is grouped
with the other type tools. 5

The Options ba pr_text::_ diffeg_e'ﬁt from the tools we have seen thus far, and includes:

_ The Tool preset pncker gives you access to customized type tools that you have
. created :

Changes'tH'é"tﬁrientation of your type from horizontal to vertical or vice versa,

":':(Eh_qc_)fs:'ej"the font family from a long list of fonts included in Photoshop.

Some fonts have styles associated with them, such as a bold version. If this is the
case, they are available on this list,

Changes the type size. Use the list to select the size, type the size directly in the
box, or click and drag over the two Ts at the left. (Dragging to the right increases
the size; dragging to the left decreases it.)
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Sets the anti-aliasing for the text. Options range from None to Smooth. f you
apply anti-aliasing, Photoshop smoothes the edges of the text out.

Choose from Left, Center, or Right alignment for your text.

Set the color of the text. The text color is independent of your foreground color.

e Warps your text according to a number of set warp styles.

At the end of the Options bar are three more buttons:

k) td":ﬁ"nish the entry,
40 keep it. The last

you are working in a file format that doesn! 1. 5 pp'o't"t layers, éuch as Multwhannel Bitmap, or
Indexed Coler mode. In this case, the type appears on the background and is rasterized.
{Rasterization is covered later in this sectron in Le son 3.4, )

You can enter type using two d|fferent techmques Each has ramifications for appearance and
editing. If you are just adding:a few words all on‘one or two lines, use point text. To add point
text, sefect the Horizontal Typ "'tooi S| tfyour options, and then click where you want to start

typing. The text appears in one: iong row: |f you want to start a new line, you must press Enter,
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The text in this image was entered as point text:

If you plan on typing a paragraph, use paragraph text. elect the Horizontal Type tool, set your
options, and then drag your mouse pomter to create a rectangle on the image. When you type,
the text WI“ be confined inside th rectangle If you type past the boundary of the rectangle,

If all of the text'doesn’t fit in the text box, the bottom right handle changes to have a t in it. This
lets you know that you need to resize the text or the bounding box. To resize the bounding box,
click and drag one of the handles. Hold the Shift key down while you drag if you want to
maintain the proportions of the box.
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Here is a bounding box that cannot display all of the text:

Text overflow indicator

A second type of Horizontal Type tool is the Horizontal Type Mask tool. You Use th’ié‘ in much
the same way as the regular Horizontal Type tool. The difference is that the ietters that you
type will create a selection. (The outline of the letters will be th’e dashed’ select;on horder). You
can use this selection just like any other type of selection: appl _ransformatlons ‘copy the
selection, make an inverse selection, etc. Masks are covered mos tho_ ughly in Lesson 4.1.

it is also important to note that the type mask wi ted on s own layer as with the
regular type tools. [t is best to avoid using the typ ,:mask ona layer _;reéted for regular type.
This is because the regular type on the layerwill have to be rasterlzed (converted from a vector
graphic to a bitmap image) before you can perform certam actions with the selection you
create with the type mask. When the reguiar type*'s rastenzed you cannot go back and edit it
as type (i.e. change the font, change the's” e delet” etters) because it has been converted to a

bitmap image.

Working with Verticgl 'i'ypé

The rules for the, ertiﬂcai-ﬁfr}e tod[ aré""i:)retty much the same as for the Horizontal Type tool,
with the important d:fference that: the type will be added to the image canvas vertically (up and
down) rather than across: (feft to r:ght)

You can still create paragraphs by selecting the Vertical Type toof and dragging out a paragraph
boundary before yott type. When you click inside the boundary and begin to type, the vertical
text will be: confined: :within the specific rectangle you made. You can also add vertical text to an
image without: usmg a paragraph box.

Just as before, the regular vertical type will be placed on its own layer above the image
background. f you use the Vertical Type Mask, a selection will be created from the outline of
the fetters you type. As before, this selection will not be on its own layer.

When you select the Vertical Type tool, you can use any of the options in the Options bar or

character palette to format or adjust the vertical type, the same way that you would adjust the
horizontal type. There is also the Vertical Type Mask tool.
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Here is an example of some vertical type.

Lioci - BRI.EK 1,840

Whether you confine your Vertical type to a paragraph box, or type it freely, the text will wrap
left to create anew'vertical ineWhen adding text without a paragraph box, you must press
the Enter key to create a:newline. Remember, you can toggle your type between vertical and
horizontal by E‘I:i_'c_:king the Text Orientation button in the Options bar.

Modif\;'i:hg Type |

When you ad'd':-t'ype‘to an image, there are a lot of modifications that you can make to it. You
can perform all of the standard changes, like setting a new font size or changing the font itself,
in pretty much the same way as you would with a word processer. The Options bar and the
Character palette are both instruments of change for your type. You can apply the changes
globally, by selecting the layer, or selectively, by selecting only the text that you want to
modify.
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This image shows a selectively applied font size change. You can see that the word United has
been selected by dragging the cursor over the word:

Once you have made the changes to your type, you can accept them by cllckmg the Commit
button on the Options bar, or reject them by clicking the Cancel button S

In addition to the basic formatting, you can warp your text and use’ iayer styles and':f)ptsons to
enhance your text. You can also perform any transformation on text as well'= otatmg, skewing

and so forth.

When you click the Warp tool on the Options bar, th.e-Warp d|alogu x“a_ppé:érs. First, choose

a style from the drop down menu, and then fine tune”_ he settmgs

[:] Arc Lower.
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There are a number of styles that you can use to warp your text, as shown here:

| Ione

T A
U e towesr
(1 e Upper

E3 Bulge
[;_'z Shefl Lowesr
7 Shell Upper

F3 Flag
Wave
[ Fish
£ Rise

[EE Fisheye.
{1 inflate

£3 Souesrs
FE] - Twist

You can warp vertical or horizontal text by seléi:’-ti_gjg thé“f‘é‘?g_t_ layer that you want to modify, and
then selecting the type of warp that you'want to apply from the list.
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The following illustration shows a few examples of the Warp effect on some simple text.

el

Y 511‘33
Hello

Hello

When you apply a warp effect, it i applled to the text Iayer that is currently active {remember,
a text layer is created when you use the Hor!zontai or Vertical Type tool). This means that your
entire sentence or paragraph {orbwhatever text is on the layer) will be warped. If you want to
warp only select words, or use lfferent warping styles for different words, you can do this by
carefully creating indiv ual lay for the different text and warping combinations.

Type that is wa m:__‘.‘the usual way, and the warp effect will be automatically

applied to the editing changéé"_l_g

Layer styles can aiso be used to enhance text; you can use them to add shadows, bevels, and
other spemal effects To'use a layer style, select the text layer, and then from the Layer menu
choose Layer Style, or click the Add a Layer Style tool at the bottom of the Layers palette. (Layer
Styles were coveréd more thoroughly in Lesson 1.4.)
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Performing a Spell Check

Whenever you are using more than a few words of text, it is always a good idea to speli check
your work, Photoshop checks all layers that aren’t locked or hidden. if you just want to check a
particular word, click in the word before starting the spell checker.

To check the spelling in your image, choose Check Spelling from the Edit menu. The spell
checker uses the fanguage set on the Character palette. For each error, Photoshop offers
replacement suggestions. Click the correct spelling, and then click Change. If you want to
change alt instances of the incorrect spelling, click Change All. To ignore the':‘é}_’__r.pr, just click
Ignore (or Ignore Al for multiple instances). "

totin Dictionary;
| Unitevel

Untillad.

i Unitive
il

L Unitized

Photoshop is not : 'word pr?:__‘_'cessor: it's an image editing application. In order to maximize the
control you have overyour text, you can use the Character palette. Using the palette, you can
decide exactly how you want your type to appear with far more control than a word processor

Toggle Character and Paragraph palettes

To view the Character palette, click the Toggle Character and Paragraph palettes button on the
Type tool Options bar, or choose Character from the Window menu.
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oyt %’am;ﬂy F_&‘}E’"ﬂ_f style
Funt size Leading
Kerning Tracking
Vertical mwmeess Horizontal eeaﬁe
Baseline shift' Color
LANGUALE e Englsh: Uss .&nti-{aﬂﬁ&ing

Several of the settings on the palette are also available on the: Optlons bar: the font family, font
style, font size, color, and anti-aliasing. The remaining settmgs are di cussed in the table below.

Kerning Sets the horizontal space bet" ‘een the indi al letters or characters.
Usually this will be set to Metrlcsf' r_EOptics, the two choices at the top of
the list of options. The: Metrtcs or Optrcs set‘tmg will use the default
kerning that was desngned for: the partlcular font. If you want to change
the default kerning, you: can do’ so by clicking in between the letters of
your text, and then entermg a valueiinto the field, or by selecting a value
from the i @

Vertical scaling You can adjust the vert;cal scaling of the text by selecting it and then
entermg Vva[ue n the vertical scale field. The size of the text will
" mcrease 0 .decreaae ver‘aca!ly only, not horizontally,

Baseline shift ... "'I\/loves the etters up or down relative to the rest of the type. A negative
*' "-f}j}_-number moves the selected text below the baseline; a positive number

'moves it above

Includes buttons for creating subscripts, superscripts, underlines,
'tinkethroughs faux bold, faux italics, and to make your text small
capitals or all capitals. (Faux bold and faux italics can be used to apply
bold or italics styles to type fonts that do not support bold or italic
characters.)

Enhancements

If you let your mouse pointer hover over each Ticon, a brief description
of its function will appear in a comment box.

Language Sets the dictionary for the type. Used for checking the spelling and
hyphenation.
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Leading Sets the space hetween your lines of text. You can set this manually by
choosing from the list, or you can choose Auto. If it is set to Auto, the
space between lines of text will be adjusted for you every time you start
a new line.

Tracking Tracking is also used to set the space between letters, but not on an
individual letter by letter basis like kerning. To adjust the tracking, select
the text you want to alter, and choose an option from the drop list, or
enter a value directly.

Horizontal scale You can adjust the horizontal scaling of the text by selecting it, and then
entering a value in the horizontal scale field. The's Ze of {
increase or decrease horizontally only, not verticaily“

In addition to the Options bar and Character palette, you can aiso rsght click ype to access a
shortcut menu with the some of the type options.

Check Spalling,.. -
l" md aﬂd leace ’f&:«t. o

fmtl Aiia 5 None
w Anti-allas Sharp
Anti-Alias Crisp
anti-Allas Strorg
Ant&»e‘alia; bmoaté

Faux Fﬁald
Fquy Itaﬂc

t>-'a-'.-_1r|:: TE;“{L;.
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Lesson 3.3: More Photoshop Drawmg Tools

Photoshop is very well known for its powerful bitmap image editing capabilities. Although not
as well known, Photoshop’s drawing and vector graphics tools are also excellent.

Just to review, a bitmap image is composed of an array of pixel values that are mapped to an x,
y coordinate system. Vector graphics, on the other hand, are lines, curves, and shapes that are
described mathematically. They can be manipulated and scaled easily without a loss in quality
because re-sampling is not involved. When a vector graphic is mampulated the underlying
mathematical vectors are adjusted appropriately (so there is no guessmg at. pixelvalues when

the size is changed).

When it is time for a vector graphic to become a hitmap :mage _ _must be rasterlzed ThIS is the
process of converting the mathematically described image into" an array of mapped pixel values.
A vector graphic must be rasterized before you can app]y many of Photoshop s'editing features

to it.

In this lesson you will learn more about the vector: graphlcs tools. You"wall learn how to use the
Shape tools, how to work with custom shape: how to.use the Pen tools, and how to
manipulate paths, '

Working with Lines and Shapes

To create a simple vector graph:c, youc n choose from among the Shape tools in the
Photoshop toolbox. Here are the Shape tool variants available from the toolbox.

Hyou choose any-o the Shape tools, the Options bar will provide a panel of buttons to access
the other Shape fools.
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The options vary slightly depending on the tool you've chosen, but remain essentially the same.

N T

At the far left of the Options bar, the current tool is shown, and you can
choose presets for the tool.

Next to this, you can choose what you want to do with your shape. You can

do one of three things:
» Create a vector shape layer {a different layer is created for each
shape)
= (Create a path {paths are discussed later in this Iesson)
» Fill in the area with the foreground color (thlS does not create a
vector drawing, but rather colors the actual plxeis in)

ckmg it on this
e Tdolbox.

You can change which drawing tool you are_ __smg by:
section of the bar. This is the same as click ___g tool 0

These options look slightly dlfferent der jendm on whether you are
drawing a path or a shape, but they Srmine what happens when you
add another shape to the d "wmg Y n add to ‘an existing shape,
subtract from an exnsting shape ‘or even mtersect the shapes.

The remaining options vary-dependmg on the shape You can set colors,
styles, end points for_imes number of sides for polygons, and so forth.
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To use a Shape tool, choose it from the toolbox, and then drag your mouse pointer over your
image or blank canvas to create a shape.

1%

e Dec B LEK I bytes i
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If you have chosen Shape Layer, then a new layer is created when you draw the shape.

e 1009

SR
e
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If you have chosen Path, then the shape appears as an outline.

i

S é?.gsg"?f

5 e . R p :
A o T YA bR R 0 i g ey
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Just like the selection tools, if you press the Shift key while you drag with the Rectangle tool,
you will create a perfect square. If you press the Shift key while you drag with the Ellipse tool,
you will create a perfect circle. To draw a straight line, select the line tool and drag your mouse
pointer over the image canvas.

Working with Custom Shapes

Custom shapes take you beyond polygons to creating many different vector: Jimages. The default
shapes are shown here, but many more are included with Photoshop, and youican create your
own. To draw with a custom shape, you do the same thing as you wouidiio draw with any other
shape. First, select the Custom Shape tool. E :
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Next, set the options, and then click and drag to create your image.
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You can also access the shape list by right-clicking in your image after selecting the Custom
Shape tool.

S

ot

If you create any shape (custom or other), and ther Edit=k eeTransform Path, a box
with move handles will appear around the shape. ""F'or example, we could add the leaf shape to
the bottom left corner of this image. Then, after choosmg Edit —Free Transform, you can right-
click the drawing and choose your tran formatron from the shortcut menu. Remember that
after you choose your transformation you must choose Commit {press Return) or Cancel {press
Escape) from the Options bar.

'nsform Path

Scale
Rotate
Sk
Distort
Perspective
\Warp

Ratate 18[1°
Retats BO° O
Rotate 90%.CCW

Elip Horizontat
Flip Vertical
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There are many more shapes than those shown on the default list. To see other shapes, click
the arrow on the shapes list. Then, choose a collection.

Text Only
Lv Small Thumbnail
; Lérga Thurbrel
Srriall List
Large Lisk

Preset Manager,..

Feset Shapes...
Load shapes...
Save Shapes.,.,

Replace Shapes. ..

Al
Arimals

AT

Banaers and Awards
Frameas

Misic

Makure

Chjects
C_Jrﬁamf:nts
Shapes

Syribcls -

Talk Bubbiss

Tiles

Web

Once you qucl;':é__gollectio ,yoﬁ"E:WiI! be prompted if you want to load it. Once you click OK, the
Shapes gallery will:contai ly the shapes from that collection.
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To add a custom shape collection, click Load Shapes, and select the file you want to add. (It
must be in CSH format.)

Custom Shapes

: '.My Recent .
Crocyments .

Hy Nzt
; Flaces

EGIassy Oelagon

Cugtorn Shapes [*.C5H)

1738

1 Text Orly
v Small Thurnbriz
Large Thurbnad
amall List
Large List

Reset S'hapes‘ "
Load _Sﬂiﬁapes. v
Save Shapes..,
Replace Shapes, .,
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You can also add your own custom shape. First, create the shape using the Pen tool (covered
shortly), and then right click your drawing. Click Define Custom Shape, and then, in the Shape
Name dialogue box, type a name. Click OK and your shape will be appended to the shape list.

3 diarmond in the rough

Using Pens

The Pen tool is another useful vector graphic tool provided in 'Phot hop rThe mam purpose of
the Pen tool is to allow you to create vector paths.
A path can be used to get very fine control for fiEling : speuf_l_e_d_ area,, applymg a paint stroke
along a predefined course, creating your own custom vector shapes or. for making selections.
The different Photoshop Pen tools provide d:fferent approaches and’ ‘options for creating paths.
Creating paths with the Pen toolsisa complex subJec aand takes.a lot of practice.

The Pen tools (de5cr|bed- ‘the ¢ rder:f:!:%:'ey appear in the box above) have the following

functions.

The standard Pen tool is used to create anchor points to join
straight lines.

This tool lets you draw with the pen in pretty much any way you
like (similar to the brush or pencil in this respect}.

Add Anchor Point Pen Tool  Use this tool to add an anchor point to a path that has already
heen drawn. Anchor points give you control over your path;
however, too many anchor points can give you unexpected results
and can make your image harder to edit, display, and print.

Delete Anchor Point Tool This tool can be used to remove unwanted anchor points from a
path.
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Convert Point Tool This tool allows you to add handles to a point, letting you drag
your path into a curve,

Drawing Straight Lines

To use the standard Pen tool to draw a straight line or a shape made of straight lines, click on
the image canvas where you want the line to begin, and then click again to complete the line.
After making the second click, you now have two anchor points. The first anchor point becomes
hollow, and the last anchor point is filled.

" point

Initial anchor
poing

can either leave the path open or close it. To Ieave it open Ctrl + cllck somewhere away from
your path. To close the path, position your pen over the initial anchor point so that an empty
circle appears beside the pen. Click and your shape will close '

Drawing Curved Lines
If you drag W|th the pen | mstead of ciickmg in different locations, you can create a curved line,
When yoy q_rag, a stralght.gf-i'ne appears called a direction line. The length and angle of the
dlrectlon' line determme the curve that you can make with the line. Draw your line about a third
of the dlstance to the n _anchor point you plan to use.

Your next actlons a :':ﬁ*dependent on the type of curve you want to draw. After drawing your
first direction line ;position your cursor where you want your next anchor point to be. Then:
* To create a single humped curve, drag in the opposite direction of the direction line you

dragged to create,
* Tocreate an S curve, drag in the same direction as the direction line you dragged to

create.

Don’t get mixed up between the direction lines, which are not part of your path, and the actual
curves, which are.
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Using the Freeform Pen

You can use the Freeform Pen tool to draw as creatively as you like. You can draw as you would
with a paintbrush or pencil to create a shape or sketch a picture.

The Pen tool options are mostly the same as the other vector tools, with the exception of the
Magnetic option for the Freeform Pen. If you select the Magnetic checkbox, the lines you draw
with the Pen tool will snap to edges or borders between strongly contrasting regions in the
image canvas you are drawing on. ' -

Adding or Déi"et_ing"hnchor Points

You can use the Anchor Point Pen tool to add anchor points to an existing path or cutline. You
simply select the Anchor Point Pen tool from the toolbox, and then click on the path where you
want to add an anchor point. You can then drag the anchor point to create and shape different

types of curves.
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By selecting Auto Add or Delete on the Options bar, the Pen tool switches automatically to the
Add Anchor Point tool when you position it over a path, and to the Delete Anchor point tool
when you position it over an anchor point.

Is é g_g__od :dea to experiment
hei selecting the Delete Anchor

as the results of your deletion may not be what ou expected
with this tool by drawing some shapes WIth anc or pomts
Point tool to remove the points. . :

If you click on a path that has no visib[é':f;;g_pchor 5’b_ir_\_ts, tH"é"-'[;‘):eIete Anchor Point pen will place
anchor points on the path, allowingyou to'delete them to alter the shape.

Adding Curves to Your Pat .

Finally, to use the Convert Poin __tooi (wh;ch is the last tool in the pen group), select it from the
toolbox, and then, cllck n an-anchor po:nt on your path. This will add handlebars to the anchor
point that you:can then manlpulate to create curves.
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Note: If you select the Shape Layers button on the Options bar, a new layer will be created for
your path, and any bounded area you draw with the Pen tools will be filled according to the fill

style or foreground color that is currently selected.

Using the Pen tools can be tricky. Knowing how to manipulate the handlebars and placing
anchor points to get the smooth curves you want will come only with practice. Try creating a
new blank canvas in Photoshop and then using the alt of the Pen tools to practice a variety of
shapes and drawing methods.

Converting a Path to a Selection

if you are drawing paths on top of an underlying image, you can tum the |mage e on_ _bounded
by your path or shape into a selection. This selection can then_be apphed toa hew layer, or
otherwise manipulated in the same way as a selection made v t’h the select] on tools

To turn a path or shapeinto a selection right click mszaé‘“%ﬁe: patﬁ o) sh'ape"and:'choose Make

Del&te ¥ eu:tu:u mask.

- )
ﬂ; ‘ Defing Custom Shape. .. ;?

Free Transform Poinks

Working W|th _Patﬁg

If you want to move your path, align multiple paths, or move only part of your path, you can
use the Path Selection tools.

* .Dn t::Et Suluc{zm Tcunl
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When you select the Path Selection tool, the Options bar changes. There are some new options
associated with this tool.

15how Bainding S

Selecting Show Bounding Box displays a bounding box around the path you select. In this image,
there are two paths ~ one is selected, the other isn’t. The bounding box makes it easy to see
what has been selected. If you don’t show the bounding box, the anchor pomts are your
guideline to what has been selected. :

include. You can then act on all the paths at once=for example moving them together around
your image - or combine them __;_nto ohe path by clic ing the Combine button on the Options
bar. Combining paths may resultin an addltaonal anchor point being added.

The remaining options are alig rh'e_nt s _ttons which control one path’s relationship to another
path. Select the paths: you wantito align, and then use the appropriate button. For example, you
can align the tops of the: path or'the mlddle of the paths,

Combine Options Align Options
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The other path selection tool available in this tool group is the Direct Selection tool.
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Lesson 3.4: Rasterization

Vector images have their uses, but often we use vector tools to create the shape we want, and
then we need to edit it. To use bitmap tools (such as retouching tools) on a vector image, we
have to rasterize the image.

In this lesson, you will learn about what rasterizing is and how to do it.

Understanding Rasterize

Unlike a bitmap image, a vector image is not described as pixels. Instead am:
algorithm describes the image. Because of this, a vector image.can be easniy resnzed and
transformed, as it simply involves a recalculation of the variables:: wever because the image
is described as a whole, instead of many small parts, th i C
limited to transformations, colors, and patterns. To do’ any:
on the image as a bitmap. Rasterizing is the process: of
image into an array of mapped pixel values.

talled_ _datmg,' you have to work
ing the,mathematically described

Using Rasterize

custom shape'to earlier. We wanted that shape in our
’ sod fit for this image. Take a look at the

Here is the flower image we adde

It looks much smoother and natural after it is rasterized. There are two easy ways to rasterize a
vector image.
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i you try to apply a tool designed for bitmap images to a vector shape (the Paint Bucket or the
Eraser for example), you will see the foliowing alert.

If you click OK, the shape will be rasterized. When this is done, it can be treated_ as _
image; however, you can no longer edit, scale, or transform the image as a: ecto grf'phrc

You can also rasterize a vector graphic by right clicking on its la er:'n the Layers palette and
choosing Rasterize Layer from the popup menu.

Laver Properties. ..
Blending Options. ..

Duplicate Laver..,
Delete Laver

Correert to Smart Object

[asahle Vector Mask
Create Clpping Mask

Sedert Sirnlar Layers

Copy Laver Style

Chear Laver Style

Iergs Dowr
Merge Yisible
Flatter Image
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Undoing Rasterize

Because you lose the ability to scale and otherwise transform a vector image after it has been
rasterized, you may decide that you want that ability back. Your ability to regain it depends on
your actions since rasterizing. The only way to undo a rasterizaton is by using the Undo feature
(only available if you haven’t done anything else) or the History palette. The History palette
stores thirty states by default, so unless you've adjusted that setting, you have a fairly limited
time before you are no longer able to return to the vector state. It is a good idea to duplicate
your image if you think you might want to revert the graphic to a vector drawing.

Flattening the Image

When you are workiny ::Wlth many Iayers to ‘create the look you want, you are usually saving
your file in Photoshop s na't e psd or .psh format, or possibly another format that at least
partially supports Iayers If you want:to save your file in a format that doesn’t support layers, all
the layers are’ ﬂattened mto one Jayer. This bears touching on at this point because in some
ways fiattenmg and rastenzmg are similar.

Both invdlve the conversion of information into one bitmap: rasterizaton mixes information
that is aIready b|tmapped with its vector description, while flattening mixes several different
sets of information for the same pixel. That information can start off as vector or as bitmapped:
if you flatten an image that has both vector layers and bitmap layers, the end result is the same
as if you had rasterized and then flattened it.

To flatten an image, simply save it as a file format that doesn’t support layers, such as GIF or
JPEG.
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Or, to manually flatten an image, select Layer — Flatten Image. Photoshop doesn’t warn you
that you are going to lose your iayers, so be sure that this is the action you want to take.

ect o Fier. - Anatysis

Miew

Mlew
Cuplicate Laver., .,

Celete

ki

Laver Propertias, .,
Layer Skvia

e Fill Layer
P Adjustmert Laver

Layer Mask
Wactor Maslk
Create Clipping Mask,

Ale+CErE

Smark Objects
Wideo Lavers
A0 Laers

Mew Laver Based Slice

Group Layers

Margps Dasan

+E

&3

atking

Chrl+E
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Section 3: Review Questions

1. Which of the following is a fill tool?
Paint brush

Pencil

Gradient

Airbrush

oo ® e

2. You can create a custom brush by... .
A Modifying an existing preset brush and then saving the mod:ﬁed vers;on as a new
brush -~ ;
B. Creating a brush from scratch, based on a parttcuiar se!ec son
Photoshop does not permit the creation of custom brushes
AandB :

o0

3. Which of the following is not a Photoshop type tool?

Horizontal Type S
Vertical Type Mask
Vertical Type
Diagonal Type Mask
All of the above

mo oW

4, When you add type to an :mage S, e
A layer for the typ:e S created automat:cally

You must create a° yer for the type ‘

The underlymg _nmage must be' converted to a vector graphic
not e t":type once itis on its own layer

oo w >

5. What |'s a vector. graphlc?

S bttmap image.

A pixel: map 1mage

A graphic thatis described with mathematical vectors and formulas
graphlc___that has been rasterized

N wr

6. In Photoshop, the Pen tools are used to...
Create paths

Color images

Write text

None of the above

oo w
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7.

10.

o0 wr

o0 wE P

v 0owr

oo w

The higher you set the tolerance for the Paint Bucket tool:

A brush paints with:

Pressing Shift when drawing with the Ellipse tool will...

Draw a straight line
Fill the eflipse
Create a selection
Draw a perfect circle

When you flatten an image, you end up with..,

Fewer [ayers than you started with
Cne layer

More layers than you started with
A vector image

The fewer pixels will be colored
The more pixels will be colored
The more the color will be saturated
Nene of the above

The background color
The brush color

The foreground color
The fill color
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Section 4: Working with Masks, Channels, and Filters

In this section you will learn about:
= Masks
» Channels
* RGBand CMYK channels
= Sefections and channels
»  Filters
*  Srnart filters

In this section you will also learn how to:
= Use layer masks
» Use vector masks
= Use clipping masks
=  Move a mask
» Create a channe] mask
= Use the Filter Gallery
*  Work with the Sharpen filter
*  Work with the Sharpen Edges filter
= Work with Blur filters
* Use the Artistic filters
" Use the Distort filters,
= Use the Pixelate filter
* Use the Noise filters
= Use other filters .

Liquify "4n.|.mage }
= Use the Pattern Maker:,
= Embed ‘ajk_‘_‘atermark inan |mage
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lLesson 4.1: Using Masks

If you know how to use masks in Photoshop, you can make a lot of tasks easier to perform and
at the same time produce better results. If you need to make a tricky selection from an image,
masks can help. If you want to protect one part of your image, and allow an effect to be applied
to another {something like a stencil), a mask is the right tool for the job.

If you want to save a selection, you can save it with a mask, and moreover, you can convert a
mask to a selection and vice versa. Learning how to use masks in combination:with layers and
selections will help you reach a new level in digital image processing.

In this lesson you will learn what a mask is and how to create one. Yo wil!'é"lso learn about
Quick Masks, selections, and layer masks. Finally, you will learn how to move a mask to from
one layer to another. : '

What is a Mask?

You can think of a mask as a kind of covering that goes overan, 1mage' Thas description may
sound a little bit like a layer, but the reality isthat masks are quite a bit different. You vary the
covering to choose what shows through the mask The default mask is a red overlay at 50%

opacity.
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Here is an image that has been masked. The red parts of the image won’t be affected by any
adjustments, filters or other edits. The white part is what we want to work on. You can see that
the mask is imperfect; it was made from a selection using the Quick Selection tool. We can
paint on the mask to select the cup more exactly.

You can only paint on masks with white;: Iack or gray. When you apply the color white to part
of a mask, you will remove thati 'art of he mask, and the underlying layer or image will be
exposed in these areasi:if you appfy bfack 1o a mask, you extend the mask, and the underlying
image will not be xposed wherever the color black is applied. You can apply this black or white
color with the-_bf tsh;, a Gradlent tool or even a Pencil tool. This means that you can lterally
paint on and off the parts of your image that you want exposed. So now, instead of just working
with selection tools to maki your selection, you can add the power of masks and brushes to
make exact select;ons

Using Qu'i'iéi(;_Mas
A Quick Mask uses a selection as its base and masks everything but your selection. This enables

you to make a rough selection, apply the mask, and then refine your selection using your
brushes.
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In this image, we want to change the color of the flowers on the teacup. Start by making a
rough selection of the teacup.

o
00 GH TR

Now we’ll refine the selectio using a:Quick Mask. First, click the Quick Mask tool on the
Toolbax (it's below the foregroun'd color) or press Q on your keyboard.

Ared overlay appears, wsth everythmg in red except your selection. This is the Quick Mask.
srushes, you can begin to refine your selection. When you applied the Quick Mask,
the foreground colbr autom_atma!ly changed to black, which extends the mask. Keep painting
and adjustlng your br shes to get the mask over everything you don’t want selected. If you
accidentally:paint the_ mask over an area you that you want exposed, just switch to a
foreground color of white and paint the mask off.
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Here we can see a close-up of the mask being refined:

When your mask is complete, you £an Now selectlvely'change the unmasked portion of your
image. For example, you might:wantito. create an adjustment layer. When you add the layer,
there is a mask thumbnall besideithe new Iayer indicating that the adjustment was only made
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Here is the Layers palette for this image after an adjustment was made to the hue of the cup to
make it more purple like the background:

Doci 400071350

Another way to approach the Quick'Mask is to open your image and then click the Quick Mask
button. Next, make biack yourforeground color, and paint the mask onto your image around
the area you want toiselect :

Using Layer Mésks

- Just seen how you can use Quick Masks to paint on selection regions and apply effects
and adjustments tovery s _'ecnﬁc image areas. It is now time to learn about another important
mask type' the layer mask.

With a layer mask; you can basically paint a layer on or off an underlying image. This is a great
way to make composite photos with elements from multiple images. To apply a layer mask,
select the layer you want to paint onto the layer below, and from the Layer menu, select Layer
Mask.

There are two types of layer masks: Reveal All and Hide All. This sets up the initial arrangement.
If you reveal all, you will be using your brushes to uncover the layer below. If you hide all, the
layer below appears over your masked layer, and you will be using your brushes to uncover the
masked layer.
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In this example, we are going to blend in another type of flower using a layer mask. Another
layer has been added to the image, as you can see here in the upper left corner:

To add the layer mask, select LayerMask ffom the Layer menu, and in this case, we are going to
Reveal All, and then use a black brush to:cover it up with the background layer.
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The layer mask appears on the Layers palette beside the selected layer. There are now two
thumbnails for the layer: the layer thumbnail and the mask thumbnail. You must select which

thumbnaif you want to work on.

1 Mask thumbnail
‘Layer thumbnail |

After you select the layer mask thumbnail, select the painting tool of your choice: paint in black
to cover your mask, and in white to uncover it After painting, you can see the mask has helped
us blend the images togethe
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To reduce your file size, once you are sure you want to keep the layer mask, you can apply it,
and the layer will permanently reflect your edits. To apply a layer mask, choose Layer ~ Layer
Mask — Apply.

Using Vector Masks

A vector mask is a mask drawn using one of the drawing tools. It creates a nice sharp edge, and
is resolution independent. Every time you draw with one of the Shape tools;you are creating a
vector mask. You can use the vector mask to selectively apply a fayer style to your image. In this
example, the second rectangle is a vector mask.

BB E7 %

Using Clipping Masks
A clipping mask lets you fill one part of an image with the content of another layer. Many

interesting effects can be created this way. A clipping mask involves at least two layers: the
base layer and the clipping layer. In this example, the word “Strawberries” has been created
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using a clipping mask. The base layer is the layer with the text on it, and the clipping layer has
the image that contains the strawberries filling the text. This image has a third layer, the
background layer with the large berries on it.

D0EK 2070

Take a look at the Layers palette for.the'image. You can see that the clipping layer is indented
above the base Iayek U can have mokr_e than one clipping layer as long as they are on top of
each other. The clipping mask'has an arrow beside it, identifying it as a clipping layer. You can
think of the base layeras a container for the clipping mask; the arrow shows you what is being

‘Clipping mask

Base layer
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To create a clipping mask, make sure the clipping mask is above the base layer. Then, select it
and choose Layer ~ Create Clipping Mask. You can also press Alt + Ctrl + G. To create a clipping
mask with your mouse in the Layers palette, hold your Alt key and click the line dividing the
base layer from the clipping mask.

i rdormal

T Press Alt and click
on the dividing line

If you don’t want the layer to be a clipping mask an‘;}l’zlbnger do one of the following: Alt + click
the dividing line in the Layers palette, press Alt: + CtrI + G or from the Layer menu choose
Release Clipping Mask. - o
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Lesson 4.2: Working with Channels

Channels, masks, and selections are all closely related. When you mask an image, you are
protecting part of an image from being modified. A Quick Mask is useful for this, but goes away
when you are finished with it. Same with a selection — you can temporarily protect part of your
image, but you'll need to remove the selection to move on with your editing. Sometimes you
know you are going to work on a selection a number of different times or ways. In this case, you
can create a channel mask, which permanently saves a selection with your, amage that you can

apply at any time.

What are Channels?

Channels store both color information and selections {or masi{s_ . Chat
images. The type of channel determines the information.they store.

Types of Channels

There can be up to three types of channeis‘m a Photoshop lmage Each stores a different type
of information.

Color Thereis a color channel for each color in your image. In RGB images, there
are three color channels (one for red, one for green, and one for blue}; in
CMYK th' eare four channels {one each for cyan, magenta, yellow, and
black). A d'tttonany, there is a composite channel that shows the image in
-'flfuil color. Each’ colorchannel contains information about a given pixel;
' ke'en them all they fully describe the pixel.

‘Spot color channeis can be used in images that are being printed. Spot
color refers to ink colors that are exactly the color you want to produce,
rather than being a combination of RGB or CMYK colors. You use a
._,hannel for each spot color you want to add.

Spot Color

An alpha channel is a user created channel that allows you to save a
selection. It appears in grayscale, where white is your selected region, and
black is protected, just like a mask.

Alpha

Using the Channels Palette

The Channels palette, in a default workspace, is the tab next to the Layers tab. The top channel
shows a full color image, and then each individual channel is shown. Any spot color channels
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would be shown next and finally any alpha channels. An image can have up to 56 channels. Like
layers, you can selectively choose which channels to display.

e Color channels:

Tools for adding and
removing ehannels

Active channel.

Visible ghannel

, it displays in gr’a:'y__scafe. When you display two color
channels, the image is no longer grayscale, but shows both'colors you have selected. If you
would prefer to always view the color:of a‘channel, not the grayscale, choose Edit — Preferences

:. F
i Parbormance

siCursers

L Transparercy 2 Garnut

Uil 8 Rulers

] Guides, Srid, Slices % Count

;;: Plug-Ing

L Type

You also can choose which channel to work in, like in the Layers palette. The active channel(s)
has a blue bar across it. You can only work on one channel at a time, and you can edit the
picture by painting in the image. Painting with white is the same as painting with 100%
intensity, while painting with black removes the selected color from the pixels you are painting.
If you paint with gray, you are reducing the selected color’s intensity.
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Here, we are working in the red channel and painting one strawberry black.

Dot E00EK L35
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If we switch back to RBG mode, we can see that this strawberry only has the blue and green
components left; painting with the black removed the red tones.

Creating an Alpha Channel
An alpha channel, also known as a channel mask, is a mask that you can invoke whenever you

need it. You can also load a channel as a selection, saving you a lot of time. Alpha channels do
not take up a lot of space in your file, so it is worth saving any selection that takes you more
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than a few minutes, even if you think you probably won’t need it again. Selections are one of
the most time consuming parts of using Photoshop, and they are hard to duplicate exactly.

To create an alpha channel, it’s easiest to start with a selection. Once you have your selection,
click the Save Selection as Channel button at the bottom of the Channels palette.
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The new palette appears with the default name of Alpha [n], where [n] is the next available
number - Alpha 1 if this is your first channel. You can double-click the channel name and type a
new one.

To see the Channel Options dialogue box, first sélect the ¢h: and:then cfick the Options

menu button on the palette.

. Mew Channel,.,
Duplicate Channel. .
Delete Channel

"I~J_'c~.w Epot Chanriel. .
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The Channel Options dialogue box allows you to name the channel and choose what you want
the channel to store. If you choose Masked Areas, you will save a channel mask, whereas if you
choose Selected Areas you will save a selection.

Any channel can be loaded as a selection by clicking the Load Chaﬁ__r_]‘_(_—:{l':"és Selection button on
the Channels palette. S .
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To delete a channel, you can right-click it and choose Delete Channel, or you can drag the
channel to the garbage can button at the bottom of the Channels palette.

Duplicate Channel, .,
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Lesson 4.3: Modifying Images with Filters

AR

Photoshop filters mimic the photographic technique of placing a filter over the fens. They can
be applied to an entire image or just part of an image, and can be used to retouch your image
or to add special effects. Filters let you unleash your creativity, and you can add some really
interesting effects using them.

In this lesson, you will learn about the Photoshop filter gallery, and several types of filters
including Smart Filters, Sharpen and Sharpen Edges filters, and Blur filters.

What Are Filters?

Filters overlay your image and are used mainly for special effects: Photoshop comes with an

extensive range of filters, although there are many third party ﬂEters avallabie You can modify
the settings and opacity for many filters, and by comb: ng faiter effects and: the order they are
applied, you have nearly endless choices for your, 'mage

Most of the filters in Photoshop are organized'by category Categories include special effects
like Artistic filters and Emboss filters, and reteuch ﬁlters 1|ke the:Sharpen filters.
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Here is the same image with two different filters applied to it. The image on top has the
Crystallize filter; the bottom image has the Film Grain filter.

YOu can access mamg:__of the commonly used filters in the Filter Gallery. Filters are applied to the
active layer, so start by selecting the layer to which you want to apply the filter. Then, to view

Licguify, .. Shif+krl4
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The Filter Gallery, shown helow, is organized into several panes.

Wikertoke

(= Fliter parameters

Palette bl U W

Pogler Edjst

Lrained Gliss Temeirer

Fwmn Dlete fller

Filter list Hide filter Add another filter

The first pane shows your image, the second is Where you choose the filter, and the third is
where you set the parameters for theichosen filter and work with the order of the filters. The
nice thing about the Filter Gallery-is the ability to try out different filters without having to
continually return to the‘menu = it’s like one stop shopping for filters. However, the Filter
Gallery doesn’t.contain all. fllférs so yolu'can't always count on it. '
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Once you have the Filter Gallery on your screen, you can collapse and expand the categories by

clicking the arrow beside them,

Pencit

Faint Craubs

Postar Edges

Cigtout

Paletts Knifs

Fough Pastels -

Gy Brush

Srrardie Stick .

Watercolor,

In the above example, the Artistic category is expanded, and all other categories are collapsed.
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Once the category is expanded, you can click a filter to see a sample of what the filter looks like
applied to the sample image. As well, the parameters on the right of the gallery change to
reflect the chosen filter. The parameters vary depending on the filter, but in alt cases you can
adjust the settings and immediately see the effect the filter will have in the image on the left. If
you only want one filter, click OK once you are satisfied.
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If you want to add another filter, click the New Effect Layer button at the bottom of the gallery.

. Palnie ey

- Flies Weap

difference. Each filteris listed in the bottom of the filter, and you can click the eye icon beside
the filter to display or hide.it. You can also click and drag to change the order of the filters, or
click the:filter and then click.the Delete Effect Layer button to get rid of a filter. When you are

finished applying filters, click OK.

Sumi-e
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About Smart Filters

If you apply a filter using the Filter Gallery, you have actually changed the contents of the layer
to which you applied the filter. If you created a new layer first, you haven’t permanently
changed the image, but if you applied the filter to the background, you have lost some of your
original image data. In previous versions of Photoshop, the only way to non-destructively apply
filters was through the use of duplicate layers. In this version of Photoshop, you can non-
destructively apply filters using the Smart Filters feature. You may still wish to make a duplicate
of your background layer, but you don’t need to duplicate every layer you want to apply a filter
to anymore. o

The first step in applying Smart Filters is to convert the layer to a Smgrt"' bject:(; \ rt Objects
are covered more fully in the Advanced course). To do this, select Convert for.Smart Eilters from
the Filter menu. You will see a warning dialogue box like this one;

Click OK to convert the layer..The'thu mbnail for:
change.

ellayer on the Layers palette indicates the

Now you can use the Filter Gallery or Filter menu to apply a filter. After you apply the filter, the
Layers palette displays the filter in the same way it displays layer effects: as indented Jayers
below the active fayer.
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3 Mavrnal

Fill} 10046

Fiﬁtér maﬁkﬁimmbﬂéﬁ

© 2010 Computrain Technical institute



Adobe Photoshop €55 Intermediate 143

Because the filter has an associated mask thumbnail, you can select the mask thumbnail, mask
parts of the image, and selectively apply the filter as you wish. In this example, the filter is not
applied to the buildings, but only to the sky and water.

R
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Working with the Sharpen Filter and Sharpen Edges Filter

Sharpening an image increases the contrast in all or part of the image. There are several
sharpening filters in Photoshop, all accessible under the Sharpen section of the Filters menu.

Eabrah,,,
Filber Gallery, ..

Arkistic

Blur

Brush Strokes
Diskork

Moise
Pixelate
Fender

Sketeh
Stz
Texturs
Wideo
Other
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Probably the most commonly used Sharpen filter is the Unsharp Mask, which sharpens the
edges in your image. Edges are defined by you: you set the threshold at which the difference is
pronounced enough for sharpening to occur. When there is a large enough difference, the
pixets on the darker side are darkened, and those on the lighter side are lightened. You also
control the amount the pixels are adjusted by setting the amount, expressed as a percentage of
the original. The radius determines how far out Photoshop performs the adjustment.

Another Sharpen filter is simply.called Sharpen. This filter is used to bring a blurred image into
focus. There are no parameters for the Sharpen filter; it is applied when you click the menu
command. If this filter is not strong enough, you can apply the Sharpen More filter. You can also
sharpen*'*-t'h_e edges s_ifhp by selecting the Sharpen Edges filter, which finds the edges and
sharpens the contrast without touching the rest of the image.
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Here is an image before and after sharpening {using Unsharp Mask):

Note that after applying many of the filters, you:can immediately reapply it to strengthen the
effect. ' 5
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Working with Blur Filters

Blur filters do just that: they blur. To blur an image, choose Filter - BI_L_lr and then ch_oose the
desired filter. - ' - T R

. Gaussian Bl ChitE

Convert For Smart Filters
Extract,. AT
Filter Gallery. . L
Liguify.., sshift-HCHrHR:
Padtern Maker,  AFShIFcHCEF
Vanishing Foirt... ALY

_s'?k}ffekr'a‘gé{.;
‘Brush Strokes. Bl
Distort . ¥ B More
Higise P Box Bl
Fixélate ¥, Gaussian B,
Render: b LensEiur.,,
Sharpen . ¥ Motion Blur...
Skstch »l Radisl Blr...
Shylize ¥i  Shape Br..,
Texture i Smart Blur..,
Yideo b Burface Blur...

P

Here is an overview of‘each Blur filter,

~Eills in the selection {or image} with the average color. if you average an
entire.image, you will end up with a one color image.

Avera_?'gi:é

Blur _l_\&lfékes the transition between hard edges and their surrounding pixels
smoother, softening the image.

Blur More Has the same effect as the Blur filter, only several times stronger.

Box Blur You set a radius, and Photoshop averages that number of pixels’ color

around each pixel. For example, if you set a 2 pixel radius, Photoshop will
average each pixel’s color with that of those within 2 pixels. The higher the
radius, the greater the effect.
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Gaussian Blur

Lens Blur

Motion Blur

Radial Blur

Shape Blur

Smart Blur

Surface Blur

Useful for making your image look hazy. Photoshop uses a weighted
average for blurring your image, and blurs more at the low end of the
frequency scale. You set a radius for Photoshop to use in its calculation;
again, the higher the radius, the greater the effect.

A more complex filter which results in some areas of your image looking
blurry and others remaining sharper.

Simulates the feeling of motion. You choose the degree in which to blur the
image and the intensity with which to blur. '

decide what radius to use.

Photoshop searches for dissi
then blurs them.

Blurs more at the center of the image:than the edges.
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Here is an image blurred in two different ways. On the top is a motion blur, and on the bottom
is a Gaussian blur.

Rk
o

-
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Lesson 4.4; Using Effects Filters

R e R

Beyond the Blur and Sharpen filters, there are many special effects you can apply. We saw
some of them in the Filter Gallery, but in this lesson we are going to take a closer look at the
Artistic filters, the Distort filters, the Pixelate filters, and the Noise filters.

Using the Artistic Filters

The Artistic filters are available in both the Filters Gallery and from the
They are used to apply effects seen in the art world. There are many artis
include things such as:
*» Colored pencil
»  Watercolor
«  fFresco
* Paint daubs
* Rough pastels
»  Smudge stick
Film grain

: c.,f'lt s, and they

Overlay biend mode applied.
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Using the Distort Filters

When you apply a Distort filter, your resulting image is geometrically distorted according to the
algorithm of the filter you selected. They can be applied from the Filter — Distort menu. These -
are very stylized filters, and can be memory intensive. They include filters such as:

In this example, our latte has been twirled.

Using thé_:._Pixeiate__:Fliters‘

Zigzag

Glass

Lens Correction
Twirl

Pinch

Spherize

Pixelate filters work by grouping pixels together. To use the Pixelate filters, select Filter —
Pixelate, and then choose the filter you want. Exactly how they are grouped together depends
on the filter you choose. For example, if you choose the Mosaic filter, the pixels are grouped
into tiles. If you choose the 'Cry'staliizé filter, the pixels are grouped into a solid colored polygon.
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In this example, the Mosaic filter has been applied.

Using the Noise Filters

'S of pixe!s in an image, such as flecks on

* Dustand Scratches whnch changes pixels that don’t fit mto their surroundings.

/ rah' which removes pixels whose brightness varies too much from neighboring
_;_prxels and adjusts the center pixel to the average brightness of the pixels around it.
‘Reduce Noisi hi h}'reduces the overall noise in an image.
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The remaining noise filter, the Add Noise filter, adds noise to the level you choose. Can you see
the noise in the latte image?

Using Other Filters

There are many other filters you can apply, al found i in the Filters menu. Take some time and
explore them, so you can add them to' your arsenal of spec:ai effects. We have examined
several categories, but you should_;_also take a look a;
= Brush Strokes, WhiCh add"“ ore artistic: effect to your image, such as Accented Edges or
Sprayed Strokes., :
*» Render, which adds
= Sketch filters, which we sa"

sketched or even'3: b,
" Stylwze f;lters, whlch reat__ hlghfy changed images which have a variety of artistic

overiay- your image of clouds, or fibers, or a camera lens flare.
v:in th”e;filters Gallery, and which can make an image look
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Lesson 4.5: Advanced Fiiter Tasks

There are several more things you can do with an image. You can apply various special effects
using the Liquify filter and you can customize a pattern for your image using the Pattern Maker.

If you need a watermark for your smage you can do that w:th a fnlter as well!l We ook at all of
these in this lesson.

Liquifying an Image

The Liquify filter has a range of tools that you can use to warp or b_ioaf%li: art'ol our image.

Filker Gallers

Corveark For Smart Filbers

Extract,.. SRR

Yarishing Feink, Ale-+CErlHY
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This will open the Liguify dialogue box:

the dialogue box. Additional options' available on the left hand side of the window include:

Clockwise twirl rofa‘tes pixels as you drag. (If you want to rotate the other way, press
Alt as you apply the effect.)

Puckerdraws in the pixels surrounding your cursor.
Bloat pushes pixels away from the cursor as you apply the effect.

Push left pushes the selected pixels to the left.

Mirror reflects the pixels perpendicular to the brush stroke.

Turbulence mixes up the pixels.
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I you make a mistake when liguifying your image, you can use the Reconstruct tool to brush
back your modifications, or click the Restore All button to start over.

In this example, the dancers on the right have had various effects applied to give them a surreal
look.

The Pattern Maker aliow_s“?\"/"o_g____to creéfé_-a layer out of all or part of an image. The pattern is tiled
to your specification: You will find the Pattern Maker command under the Filter menu.

Filar Gallery

Corvert for Smart Fiters

Extract,.. AlEHChrix
Filter Gallery...
Liguify... ShiFt4+Chel+x
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Using the Pattern Maker dialogue box, shown below, you can select a part of the image to
create the pattern, and then apply it using the parameters you set. The active layer will be
converted to this pattern, so make sure you are working on a duplicate fayer, or a layer selected
specifically to become a pattern. Not only can you use an element of the current image as a
pattern, but you can copy a selection from another image and use it as a pattern.
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Once you select the area from which to create the pattern, Photoshop can generate different
tites from it. The Generate button changes to a Generate Again button and the Tile History
section stores the versions of the tile. We suggest that you generate several, and then using the
Tile History buttons, move to your choice. Click OK and the active layer will be covered with
your pattern. o g : SR
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In the example below, the sunflower itself was selected to be the pattern. Then the sunflower
was masked off and some adjustment layers were added. The end result is completely different
from our starting point.

Embedding a Wé‘termark in an Image

Photoshop provides a way to digitally watermark your image to protect it from copyright
infringement. For full protection, you need to register with Digimarc.com. This will give you a
unigue identification that will be invisibly embedded onto your image. Digimarc also backs up
your pertfolio, and gives users an easy way to link back to you, making your watermark a
marketing tool.
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Once you have your identification, choose Digimarc from the Filter menu. Click the Personalize
button to enter your ID, and then click OK in the Personalize dialogue box.

In the Embed Watermark dialogue box'?' gu can sefect the‘information you want to display.
Shown above is the copyright year,: but, yo" could chioose to instead display a Transaction iD or
image ID. Add any additional :nformati ‘n‘_by check g the appropriate box, and then choose the
visihility and durability setting.you des1 Click OK to finish your watermark, and you’ll see a

confirmation dialogue box.
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To read a watermark, select Filter — Digimarc ~ Read Watermark. The Watermark Information
dialogue box appears. The URL at the bottom links to the Digimarc page containing your
personal information, which you can access by clicking the Web Lookup button.
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Section 4: Review Questions

1. Which of the following is not a type of mask:
Vector

Channel

tayer

Path

oo w e

2. When you are working with a Quick Mask, what color do you use t&""f'g!l_y mask or

protect your image?
Black
White
Gray

Foreground color

o0 ® >

New Chaninel
Channet 0
Channel 1
Alpha 1

OO w

4, The best type of mask to:u:
Vector mask
Layer mask
Clipping mask
Channel mask

o0 w»

5, To create a clipping: mask:with your mouse or keyboard:

A. Press Alt+ Ctrl + G,

“’From the Layer menu; select Create Clipping Mask

lette, Alt + click the border between the clipping mask layer and hase

6. Which of the following is not a type of channel?
Color

Spot Color

Filter

Alpha

N
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7.

10.

O Oow >

OO w e

on®»
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Which of the following filter categories is not available in the Filter Gallery?
Blur
Artistic
Distort
Texture

If you wanted to sharpen your image with the greatest control, which filter would you
use?
Sharpen
Sharpen More
Sharpen Edges
Unsharp Mask

The best way to apply filters non-destructively is to: .
Apply the filter to the Background layer
Duplicate the layer before applying the filter
Convert the layer to a Smart Object '
None of the above

A watermark created in Photoshopican cohfai_n:
Copyright date(s) o
Your name
The version of Photosh
File name .
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